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General informationGeneral informationGeneral informationGeneral information    
The following description covers all the functions available in Term Web Professional V3.  
The functions, and also the dictionaries and dictionary sections, to which you have access, are 
associated with your user group and authorization.  
ImportantImportantImportantImportant    notenotenotenote: Certain functions described in this document may or may not be available in 
your installation (or enabled by the administrator of your installation). 

Log inLog inLog inLog in    

 
Enter your company name (ClientClientClientClient) if it has not been automatically entered, your User name User name User name User name and 
PasswordPasswordPasswordPassword issued by the administrator and then click Log inLog inLog inLog in. (In applicable cases, also please 
select user interface language.) 
If the administrator and installation require that members of your group change password at 
regular intervals, the following dialog will appear after that interval: 

 
Then just enter a new password twice and click SaveSaveSaveSave. 
You use the same process if you have got an email with information about your new account 
and the administrator requires you to select and fill in a password before logging in. 
If the multiple-client function has been enabled, the login dialog will look like this: 

 
If you are a user in just one client, the user name and password will give you access to the 
selected data of that client. 
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If you are defined as a multiple-client user (defined with the same login credentials in more 
than one client), you will be asked to select the client in a separate dialog: 

 
Then select the client from the list and click SelectSelectSelectSelect to log in. 
 
If you are already logged in but want to log in using a different authorization, log off (click Log Log Log Log 
out out out out in the top right-hand side of the window), enter the new User nameUser nameUser nameUser name and PasswordPasswordPasswordPassword issued by 
the administrator and click Log inLog inLog inLog in. 
Note:Note:Note:Note: If you have a multiple-user-interface-languages installation, you should first select the 
desired language. 
 
In case you have forgotten your password and the show forgotten link function has been 
enabled by the administrator, you can click the Forgot Password?Forgot Password?Forgot Password?Forgot Password? link. Then you will get a dialog  

 
where you enter your client name and user login name.  
The following is displayed: 

 
Then just click Back to Login PageBack to Login PageBack to Login PageBack to Login Page. 
An email will then be sent to your email address registered in TermWeb with a link that you can 
use to set a new password: 

 
Enter the desired new password twice and click SaveSaveSaveSave, and you will be able to log in using the 
new credentials. 
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OverviewOverviewOverviewOverview    

 

 

 
 
The number of terms in the current source language (possibly filtered) term list isThe number of terms in the current source language (possibly filtered) term list isThe number of terms in the current source language (possibly filtered) term list isThe number of terms in the current source language (possibly filtered) term list is    shown at the shown at the shown at the shown at the 
bottom of the list. (For more than 200 terms, page using the right arrowbottom of the list. (For more than 200 terms, page using the right arrowbottom of the list. (For more than 200 terms, page using the right arrowbottom of the list. (For more than 200 terms, page using the right arrow    below the term listbelow the term listbelow the term listbelow the term list....))))::::    
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Set the source language, target language and how much you want to view in the Set the source language, target language and how much you want to view in the Set the source language, target language and how much you want to view in the Set the source language, target language and how much you want to view in the 
result paneresult paneresult paneresult pane    
If you want to find a term in a language other than the current source language, then select the 
desired source language from the dropdown in the SourceSourceSourceSource field. 
 
You can also limit the results shown to one target language. 
Click the box beside TargetTargetTargetTarget above the result pane and choose the desired target language. 
If you would like all languages to be displayed, choose All languagesAll languagesAll languagesAll languages in the Target Target Target Target box.  
To specify how much term information is shown for each language in the dictionary: 
Click on Custom viewCustom viewCustom viewCustom view and choose which languages should be shown along with the level of 
detail you want for each language (i.e. the term only or all term information). 
Using one of the Select allSelect allSelect allSelect all links, you can choose to show all language terms expanded or 
collapsed or hide all languages. Please note that the term in focus will always be displayed 
expanded (with maximum term information as defined by the view applied to the user's group). 
Then choose Custom Custom Custom Custom from the TargetTargetTargetTarget dropdown. 
 
If you (are authorized and) would like to display the concept's history (information about when 

and by whom the term record was created and changed), click Click  (previously 
SettingsSettingsSettingsSettings) and check the Show history Show history Show history Show history box. Deselect the Show historyShow historyShow historyShow history checkbox when you want 
to hide the information. 
If you would like another date format displayed (the default is the ISO format YYYY-MM-DD), 

click the cogwheel icon  and select the desired date format pattern from the Show dates Show dates Show dates Show dates 
as as as as dropdown. 

 
 
Then, in the example, date fields as well creation date and change date metadata will be 
displayed in the selected date format: 
 

 
Note!Note!Note!Note!    
The administrator can also specify which fields are displayed for each user, e.g. which level of 
information is shown. A single term record can thus be displayed differently depending on 
which user is logged in. 
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Search for a termSearch for a termSearch for a termSearch for a term    
You may want to choose the dictionary first. See What is a dictionary?. 
If you want to limit the search to certain sections in the dictionary, begin by choosing the 
desired sections. See the section What is a section?. 
Select the language of the term you want to find.  
If you want to search for a term in Spanish, for example, then select SpanishSpanishSpanishSpanish from the SourceSourceSourceSource 
dropdown. 
Then type the search string in the Search Search Search Search field. 
If you want to limit the search to a certain domain or subdomain, click Domain searchDomain searchDomain searchDomain search under the 
search field and select the domain(s). See also the section entitled Show a particular domain or 
subdomain. 
The default search methods may vary according to the settings made at installation time (as an 
example if asterisks are needed or not). 
Example 1:Example 1:Example 1:Example 1: Type dog* and click SearchSearchSearchSearch. A list of all the terms beginning with “dog” will be 
shown. 
Example 2:Example 2:Example 2:Example 2: Type *dog* and click SearchSearchSearchSearch. A list of all the terms that contain the text string “dog", 
e.g. 'dog', 'army dog training centre' and 'watchdog' will be shown. 
Example 3:Example 3:Example 3:Example 3: Type dog and click SearchSearchSearchSearch. A list including the term “dog" and following terms will 
be shown. 
Click the term you want to see. 
If more than two languages are displayed and you want to see all the information in a particular 
language for a given term, click the term in the desired language. The term and all of its 
detailed information will be shown in the result pane. 
(See also information for customizing the display under “Set the source language, target 
language and how much you want to view in the result pane” above.) 

Advanced searchAdvanced searchAdvanced searchAdvanced search    
If you are not sure of the spelling, or wish to search for a term or character string in fields other 
than the term field, you can use the Advanced search options. Also, you can select if you want 
to clear the search field (or keep the search string) when changing search language and choose 
if you want to enable normalized search.  

Fuzzy seaFuzzy seaFuzzy seaFuzzy searches rches rches rches ----    searching for approximate stringssearching for approximate stringssearching for approximate stringssearching for approximate strings    

If you are unsure of the exact spelling of the term: 

1. Click on the advanced search button ( ). (To close the dialog, just click the button 
again.) 

2. Check the box Enable fuzzy search Enable fuzzy search Enable fuzzy search Enable fuzzy search and then click ApplyApplyApplyApply.  
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3. The button for advanced searches changes color: . 
4. Write the term “plattform" or a part of the term (without asterisks, unless the text you are 

looking for includes asterisks) in the search field, with Italian as the source language. The 
terms that approximately match the search string will be shown, e.g. piattaforma.  

Search in multiple fieldsSearch in multiple fieldsSearch in multiple fieldsSearch in multiple fields    

If you want to search for a particular string that might be found not only in a term but even in a 
definition or comment field: 

1. Click on the advanced search button ( ). 
2. Check the box Enable multiEnable multiEnable multiEnable multi----field search. field search. field search. field search. Check then the Selected fieldsSelected fieldsSelected fieldsSelected fields box and choose the 

fields that you want to search. Click ApplyApplyApplyApply.  

 
3. Type the search string (without asterisks, unless the text you are looking for includes 

asterisks) in the search field. All the term records are then shown where some part of the 
chosen fields (on the concept level as well as the source language term fields) includes the 

search string. Note that the advanced search button changes color  when the multi-
field search option is activated. 

 

Clear search on language changeClear search on language changeClear search on language changeClear search on language change    

Select this checkbox if you do not want to keep the search string when you change Source 
language.  
If you want to search for the same string after having changed Source language, please deselect 
this checkbox.  

Enable normalized search (singleEnable normalized search (singleEnable normalized search (singleEnable normalized search (single----byte and doublebyte and doublebyte and doublebyte and double----byte characters)byte characters)byte characters)byte characters)    

This option applies to wildcard searching only. If you select this option, characters with the 
same function but stored differently, as single-byte or double-byte characters, will be 
considered equal during filtering and term list sorting. If the option is selected, the normalized 
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value will be used in filter criteria and thus filters can return results for both single-byte and 
double-byte characters. Also, normalized values are used when calculating the term list order so 
that both single-byte and double-byte characters are considered equally during term indexing. 
(For existing entries in existing pre-3.18 databases the administrator will have to reindex the 
dictionary for the new term list order to take effect.) 

TwoTwoTwoTwo----language search and displaylanguage search and displaylanguage search and displaylanguage search and display    
To search for a string simultaneously in two languages, click the right-arrow > below the 
cogwheel icon:  

 

Then select one of the following options:  
a) If you just want to display the second language terms corresponding to the search results in 
the first language, select Display termsDisplay termsDisplay termsDisplay terms in the Right columnRight columnRight columnRight column dropdown. Then select SourceSourceSourceSource 
(language) under “Right column”:  

 
b) If you want to perform the search also in the second language and display all results, select 
Display and searchDisplay and searchDisplay and searchDisplay and search in the Right columnRight columnRight columnRight column dropdown and then select SourceSourceSourceSource (language) under 
“Right column”.  
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Here, all the terms in either of the languages fulfilling the search criterion are displayed, paired 
with one corresponding term in the other language. If no term exists in the other language, 
there will be an empty space in the column of that language.  
If you then want to narrow the two columns, click the left-arrow <<<<  
To widen the columns and view the right column options again, click the right-arrow >>>>. 
To disable two-language search and display, select DisabledDisabledDisabledDisabled in the Right columnRight columnRight columnRight column dropdown (and 
preferably click the left-arrow <<<<) 
Please note that the two-language search and display setting is user-specific and remembered 
between logins.  

Use filters to search and exportUse filters to search and exportUse filters to search and exportUse filters to search and export    
If you want to search for term records or term equivalents that fulfill specific criteria, e.g. all 
term records that do not have a definition, term records that do not have a term equivalent in a 
certain language or term equivalents in a certain language with a certain status, you can use 
the filter function. 
Note! Note! Note! Note! A filter limits the search to the selected dictionary (current main dictionary). A filter can 
be defined to be private (only accessible for the creator) by setting its visibility to OwnerOwnerOwnerOwner or 
accessible for a certain group selected in the VisibilityVisibilityVisibilityVisibility dropdown, or to all users, if Default groupDefault groupDefault groupDefault group 
is selected in the Visibility dropdown. However, only the owner of the filter, or an administrator, 
can edit or delete a filter.  
If an administrator is unable to delete a filter, it is because it is in use (in an export setting or as 
a standard filter for a group). 
 
You can use several combinations of conditions in the filter. 
You can also select a combination of filters, see below. 
You can create a set of filters for a certain dictionary and then select them from the FilterFilterFilterFilter 
dropdown or by clicking the Filters icon and then > Apply filterApply filterApply filterApply filter. Note that the term list gets a 
yellow background to signal that a filter is applied. Filters can also be applied to term export by 
clicking on the AdminAdminAdminAdmin icon and then on the ExportExportExportExport icon. The filter is then chosen under Export Export Export Export 
settingssettingssettingssettings in the Select concepts by filterSelect concepts by filterSelect concepts by filterSelect concepts by filter field. 
The conditions for the field contents can be set as follows: 
a) fields that contain an exact string (typed after “EQUALS” or, if you do not enter a search 
string, empty fields) 
b) fields that contain the string and additional contents (typed after “CONTAINS”) 
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c) fields that do not contain the string (typed after “NOT CONTAINS”) 
d) fields that are not equivalent to a specific string (typed after “NOT EQUALS” or, if you do not 
enter a search string, fields that contain something; i.e. “not equal to nothing") 
e) fields that start with a certain string (typed after STARTS WITH) 
f) for certain fields: that fulfill a specific time value, e.g. that were changed before (BEFORE) or 
after (AFTER) a specific point in time (date and time) or on a specific date (EQUALS), or outside 
of a specific date (NOT EQUALS) 
g) for numeric fields: where the field value EQUALS, NOT EQUALS, is LESS THAN or GREATER 
THAN a typed-in integer value 
 

Temporary and saved filtersTemporary and saved filtersTemporary and saved filtersTemporary and saved filters    

You can create a temporary filter. (If you want to reuse it you can save it later.) 
 
To create a temporary filter: 

1. Click  beside the Search button. 
2. Click Create temporary filterCreate temporary filterCreate temporary filterCreate temporary filter. 
3. Enter filter criteria in the dialog box. 

Example A: 

 
4. Click ApplyApplyApplyApply. 

Only the term records that fulfill the criteria you have entered are shown.  
In the example, only those term records are shown that have at least one term (in any 
language) that contains the string "frequenc". 
 
Example B: If you want to show only the terms that contain a certain string (not their 
possible synonyms) in the term list, select TermTermTermTerm instead of Concept in the Filtering outFiltering outFiltering outFiltering out 
dropdown: 

In this example, only those terms are shown in the term list that contain the string 
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"frequenc" (in the current source language). 
 
 
 

5. The temporary filter is applied to the current main dictionary until you create a new 
temporary filter for any dictionary. 

 

 
6. If you want to deactivate the filter, select <No filter> in the Filter Filter Filter Filter dropdown box in the 

upper left-hand column:::: 

 

7. If you want to edit or save the filter, click the filters icon  again. 
 

If you want to create and save a filter or edit an existing filter, use the  button and click Add Add Add Add 
new filternew filternew filternew filter or click EditEditEditEdit to the right of the filter name. See the example below. 
    
If you want to send a permalink for a filter, click the green permalink icon on the line of the 
filter and (as an example) copy the permalink (shown in the web browser address field) into a 
message to the person with whom you want to share the filter.  
Please note that the filter has to be visible for the recipient's user group or to All users and the 
user has to have the rights to view the dictionary or section (or the user has to be an 
administrator). This way the recipient will see a number of concepts (as allowed by permission 
schemes) instead of a single concept as is the case for a concept (or term) permalink.    
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Example:Example:Example:Example:    
You can filter term records on the basis of the concept level fields that apply to the term record 
or to the fields that belong to the terms of a certain language (under Term level).  
Note!Note!Note!Note! Use only search strings in the field, notnotnotnot wildcard characters. 
All filters are private, i.e. connected to a specific user name. Filters that have been created by 
the administrator can, however, be applied by other users if selected to be visible for, as an 
example, All users or Guests. 
Note: All the exampNote: All the exampNote: All the exampNote: All the examples below are taken from the TechniTerm glossary.les below are taken from the TechniTerm glossary.les below are taken from the TechniTerm glossary.les below are taken from the TechniTerm glossary.    
ExampleExampleExampleExample: To find all the term records with definitions containing the text string phase shift:  

1. Click the Filters Filters Filters Filters icon . 
2. Click Add new filter>>Add new filter>>Add new filter>>Add new filter>>. 
3. Name the filter. Note! A filter name cannot be more than 25 characters. 
4. Indicate whether the filter should be available to yourself only or to all users within a 

specific user group in the VisibilityVisibilityVisibilityVisibility field. (Please note: Administrators can see and use all 
filters.) 

5. Select ConceptConceptConceptConcept in the Filtering outFiltering outFiltering outFiltering out dropdown. 
6. Replace the text <Select field> with the name of the field, for example Definition.Definition.Definition.Definition. Select 

CONTAINSCONTAINSCONTAINSCONTAINS in the box beside it and fill in the search string, e.g. phase shift.  
Click SaveSaveSaveSave and then Apply Apply Apply Apply by the filter’s name if you want to use the new filter immediately.  
(If the filter is already selected (applied) when editing in the future, simply click CloseCloseCloseClose.) 
All the term records with definitions containing phase shift will be shown. 

7. Click the term you want to see. 
 
Example 2Example 2Example 2Example 2: To find all the term records with phase shift in their definition and key in any of the 
English terms:  

1. Click the Filters Filters Filters Filters icon . 
2. Click Add new filter>>Add new filter>>Add new filter>>Add new filter>>. 
3. Name the filter and indicate its visibility. 
4. Select ConceptConceptConceptConcept in the Filtering outFiltering outFiltering outFiltering out dropdown. 
5. Select a field from the Filter criteria dropdown <Select field> such as DefinitionDefinitionDefinitionDefinition (make sure 

that CONTAINSCONTAINSCONTAINSCONTAINS is selected in the box to the right of Definition), and fill in a search string in 
the box that appears to the right of CONTAINS, e.g. phase shift.  
Select ANDANDANDAND in the dropdown below Definition (instead of <No operator>).  
Choose TermTermTermTerm and EXISTSEXISTSEXISTSEXISTS on the next line.  
On the line, under Term Criteria, choose TermTermTermTerm and CONTAINSCONTAINSCONTAINSCONTAINS and write key in the field to 
the right of CONTAINS. 
Choose ANDANDANDAND in the dropdown (instead of <No operator>).  
Choose Language, EQLanguage, EQLanguage, EQLanguage, EQUALSUALSUALSUALS and EnglishEnglishEnglishEnglish on the next line.  
Click SaveSaveSaveSave and then Apply Apply Apply Apply by the filter’s name if you want to use the new filter immediately.  

6. Click the term you want to see. 
 
Note! 1Note! 1Note! 1Note! 1: If you want to deactivate the filter, select <No filter> in the Filter Filter Filter Filter dropdown in the left-

hand column.... 
Note! 2Note! 2Note! 2Note! 2: If you want to use a previously defined filter, then select the filter shown in this Filter Filter Filter Filter 

dropdown: 
    
Example 3Example 3Example 3Example 3: Find all the term records that have a definition and a term with Usage USA: 

1. Click the Filters Filters Filters Filters icon .. 



 
17 (123) 

© 2018 Interverbum Technology AB Admin_and_User_Manual_TWPro_V3.18_R1B_EN.rtf 2018-02-23 

 
 

2. Click AdAdAdAdd new filter>>d new filter>>d new filter>>d new filter>>. 
3. Name the filter and indicate its visibility. 
4. Select ConceptConceptConceptConcept in the Filtering outFiltering outFiltering outFiltering out dropdown if you want to filter out concepts irrespective 

of source language, or select Term Term Term Term in the Filtering outFiltering outFiltering outFiltering out dropdown if you only want to display 
these concepts when English is the source language. 

5. Replace the text <Select field> in the dropdown with DefinitionDefinitionDefinitionDefinition.  
Make sure that NOT EQUALSNOT EQUALSNOT EQUALSNOT EQUALS appears in the box to the right.  
Do not fill in anything in the box that appeared to the right of the NOT EQUALS field.  
Then choose ANDANDANDAND from the dropdown (instead of <No operator>).  
Choose TermTermTermTerm and EXISTSEXISTSEXISTSEXISTS on the next line.  
On the line under Term Criteria, choose UsageUsageUsageUsage and EQUALSEQUALSEQUALSEQUALS and select USAUSAUSAUSA from the 
dropdown to the right of EQUALS.  
Click SaveSaveSaveSave and then Apply Apply Apply Apply by the filter’s name if you want to use the new filter immediately.  

6. Click the term you want to see. 
    
Example 4Example 4Example 4Example 4: Find all the term records that have been changed during the last week: 

1. Click the Filters Filters Filters Filters icon .. 
2. Click Add new filter>>Add new filter>>Add new filter>>Add new filter>>. 
3. Fill in the dialog in a similar way as below, selecting a date 7 days before today's date and 

ticking the RelativeRelativeRelativeRelative tickbox: 

 
4. When the filter is applied at a later date than 2014-07-29, it will present not term records 

that were changed after 2014-07-22, but that were changed during the seven days 
preceding the actual date. Please note that only full 24-hour periods are counted. 

Applying a combination of filtersApplying a combination of filtersApplying a combination of filtersApplying a combination of filters    

Instead of building many filters with combinations of conditions, you can apply two or more 
filters. As an example, if you want to check new concepts missing a term in a specific language, 
you can combine a date filter with one of existing filters for missing terms in the desired 
language. 
Proceed as follows:  

1) Click the Filter icon  
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2) Click ApplyApplyApplyApply by the filters you want to use. 

 
OR: 

 
3) Click OKOKOKOK.  
The term list will then show all concepts fulfilling the conditions of both filters. 
Please note that  
a) only one of the selected filters will be shown in the FilterFilterFilterFilter dropdown: 

 
b) selecting another filter in the FilterFilterFilterFilter dropdown will deselect any additional filters. 

Clicked terms markingClicked terms markingClicked terms markingClicked terms marking    
As an option, terms clicked in the term list can be given a tickmark. See illustration below.  
You activate this function by clicking the cogwheel below the term list:  

  
and ticking the Show marShow marShow marShow markings for visited termskings for visited termskings for visited termskings for visited terms    tickbox:  

 
(To deselect the function, just deselect the tickbox.) 
To clear the markings, just do a new search. If enabled in your installation, the markings will be 
persistent, even until your next login. If you want to clear these markings for visited terms, 

please click the little red and blue eraser symbol ( ) below the term list.    
    



 
19 (123) 

© 2018 Interverbum Technology AB Admin_and_User_Manual_TWPro_V3.18_R1B_EN.rtf 2018-02-23 

 
 

    

Creating a permalink Creating a permalink Creating a permalink Creating a permalink to refer to to refer to to refer to to refer to a a a a term record term record term record term record     
To create a link to a specific term record: 
1. Click the desired term in the term list. 

2. Click the green Permalink button  in the upper right part of the result window. 
3. Copy the link information from the web browser address field. 
4. Paste and use this link in other documents, to refer to the specific term or term record.  

Please note: A link similar to the following refers to a specific term; 
http://demo.termweb.se/termweb/view/3d31b/9qp4f, whereas the link 
http://demo.termweb.se/termweb/view/3d31b refers to the whole term record. 

5. Users who are not authorized to see the term record (e.g. guest users), will get a TermWeb 
view with no concept in focus (empty result window). 

Please note that you can also create a permalink for a filter. See above under Temporary and 
saved filters. 

Enter a new term record Enter a new term record Enter a new term record Enter a new term record     
Please note that a new terminological record (concept) can also be added from Grid View (see 
below). 
1. Check first to make sure that the term, with the same or a similar definition, does not 

already exist in a dictionary. This can be done for many "term candidates" at a time using 
the Batch Search Tool, see below. 
Otherwise, see Search for a term above. 
Please note that while editing you can “restore” and return to the previous page by pressing 
Alt+XAlt+XAlt+XAlt+X    (in Internet Explorer) or Alt+shift+XAlt+shift+XAlt+shift+XAlt+shift+X (in Mozilla Firefox), or by clicking Cancel at the 

bottom of the windowpane, or by clicking on the red x icon  in the upper right-hand 
corner of the windowpane. 
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2. Click the NewNewNewNew icon .  
3. Press Alt+OAlt+OAlt+OAlt+O (in Internet Explorer) or click Edit concept level fields...Edit concept level fields...Edit concept level fields...Edit concept level fields.... Enter the information 

you have for the concept level fields, e.g. enter the term’s definition and specify the domain 
and subdomain. For more information about domains, see the section Show a particular 
domain or subdomain.) 
In order to show as much of the domain selection frame as possible, you can switch to full 
screen view (F11 in Internet Explorer). Specify the term record subdomain(s) by clicking 
Select domainsSelect domainsSelect domainsSelect domains and then the plus sign beside the desired domain and subdomain. 
Here you can also choose the section in which the term record will be placed. 
Then press Alt+SAlt+SAlt+SAlt+S (in Internet Explorer) or click on Save.Save.Save.Save. 

4. Press Alt+AAlt+AAlt+AAlt+A (in Internet Explorer) or click on Add term...Add term...Add term...Add term..., choose the language and fill in the 
term along with the information for the chosen language. Then press Alt+SAlt+SAlt+SAlt+S (in Internet 

Explorer) or click on the green tick icon  in the upper right-hand corner or click on SaveSaveSaveSave 
at the bottom of the page. 
 
 
 
 
 
 
 
 
Duplicity check: Duplicity check: Duplicity check: Duplicity check: When you click Save, in case there is already a homonym (homograph) 
term, i.e. a term with the same spelling, in the same language, in the present dictionary, you 
will get a question like the following:  

This gives you the possibility to skip creating a new concept with the term (in case the 
existing term is representing an identical or very similar concept) or click Yes and go on 
creating the concept with the identified duplicate term. 
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5. If you want to enter a term in another language, click either  

Add termAdd termAdd termAdd term...   (AAAAlt+Alt+Alt+Alt+A in Internet Explorer) or Copy term... Copy term... Copy term... Copy term...  (Alt+CAlt+CAlt+CAlt+C    in Internet 
Explorer), select the new language and enter the term as instructed in the previous step. 

6. Press Alt+SAlt+SAlt+SAlt+S (in Internet Explorer) or click SaveSaveSaveSave when you have finished updating the term 
record.  
If you want to create another term record, press Alt+NAlt+NAlt+NAlt+N (in Internet Explorer) or click 
SaveSaveSaveSave    &&&&    NewNewNewNew. 
If you want to create another term record based on the current entry, click SaveSaveSaveSave    &&&&    Duplicate Duplicate Duplicate Duplicate 
(Alt+DAlt+DAlt+DAlt+D in Internet Explorer). In the latter case, all information will be duplicated, including 
the information about the domain(s) and section. 
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Check for existCheck for existCheck for existCheck for existing ing ing ing terms in a dictionary terms in a dictionary terms in a dictionary terms in a dictionary ––––    Batch Search Tool Batch Search Tool Batch Search Tool Batch Search Tool     
If you want to check what terms are already in a dictionary before importing or adding a set of 
new terms, use the Batch Search Tool. The search terms can be entered manually or imported 
from a simple Excel file, and the customizable report of found terms can also be exported as an 
Excel file. 
Do as follows: 
1. Click AdminAdminAdminAdmin and then click the Batch Search Tool icon. 
2. Select the dictionary you wish to search, and the language of the search terms. Then either 

enter (type or paste) the terms you wish to look up in the box, as in the example below. As 
an alternative, save the term candidates in the leftmost column of an Excel file, click the 
Excel fileExcel fileExcel fileExcel file radio button, browse to and select that file. Please note: Only the first sheet in the 
file is read, any additional sheets are ignored. 

. 
3. Click ContinueContinueContinueContinue. 
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4. Select the fields to be included in the report for found terms on the RepoRepoRepoReport Field Selectionrt Field Selectionrt Field Selectionrt Field Selection 
tab. 

 
 

5. Click SearchSearchSearchSearch to start the search. 
6. The report, including the text and values of the selected fields is displayed on the ReportReportReportReport 

tab. If you wish to save it as an Excel file, click the    » Export to Excel » Export to Excel » Export to Excel » Export to Excel link:  

 
 

7. The entered search data, report settings, as well as the latest generated report, are kept 
during the user’s session. Dictionary and source language selections are saved and restored 
for the user’s next session. 
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Enter a new term record based on an existing term record Enter a new term record based on an existing term record Enter a new term record based on an existing term record Enter a new term record based on an existing term record     
1. Check first to make sure that the term, with the same or a similar definition, does not 

already exist in a dictionary. This can be done for many "term candidates" at a time using 
the Batch Search Tool, see above. 
Otherwise, see Search for a term above. 

2. Click on a term from the term list that you would like to use as a template. 

3. Click on the CopyCopyCopyCopy icon . 
4. Continue from step 3 Change a term record below. 
 

Change a term record Change a term record Change a term record Change a term record     
Please note:Please note:Please note:Please note: For change of more than one term record, the Grid View editing mode, described 
below, is recommended. 
You can easily change or modify a term record, including the information in the concept level 
fields and the information about term equivalents in each language. 
For example, if you want to change the information about a German term equivalent: 
1. Show the term record. Click on the term in the list in the left-hand column to make the 

contents of the term record visible in the result pane to the right. 

2. Click the Edit Edit Edit Edit icon . 
3. Click the German term (if German has not already been set as the source language). 
4. Click Edit term Edit term Edit term Edit term (Alt+EAlt+EAlt+EAlt+E in Internet Explorer).  
5. Change or add the desired information in the fields shown. 

If you want to copycopycopycopy a certain field valuefield valuefield valuefield value, e.g. “Source” or “Part of speech” to all existing 
terms (in all languages) in the concept, select or type a field value and click the  icon to 
the right of the field and confirm the operation. The field value will the be copied to the 
field in all terms in the concept, replacing any previous content of the field.  
Please note: This function does not apply to multi-line fields. 

6. Click the green tick mark at the upper right-hand side of the term field box or click SaveSaveSaveSave. 
7. If you want to change a term equivalent in another language: 

Click the term in that language. 
Click Edit term Edit term Edit term Edit term (Alt+EAlt+EAlt+EAlt+E in Internet Explorer).    
Change the information and then press Alt+S Alt+S Alt+S Alt+S (in Internet Explorer) or click on the green tick 
at the upper right-hand side of the window or click SaveSaveSaveSave. 

8. If you want to change the information in the concept level fields, press Alt+OAlt+OAlt+OAlt+O (in Internet 
Explorer) or click Edit conEdit conEdit conEdit concept level fields...cept level fields...cept level fields...cept level fields..., change the information and then press Alt+SAlt+SAlt+SAlt+S (in 
Internet Explorer) or click SaveSaveSaveSave. 

9. Press Alt+SAlt+SAlt+SAlt+S (in Internet Explorer) or SaveSaveSaveSave in the button field at the bottom of the window 
when you have finished updating the term record. 

Add a term tAdd a term tAdd a term tAdd a term to an existing term recordo an existing term recordo an existing term recordo an existing term record    

You can add a new term equivalent in another language to an existing term record. 
If you wish to add a Portuguese term equivalent, for example, do the following: 
1. Show the term record. Click on the term from the list so the content of the term record will 

be visible in the result pane. 

2. Click the Edit Edit Edit Edit icon . 
3. Press Alt+AAlt+AAlt+AAlt+A (in Internet Explorer) or click Add term...Add term...Add term...Add term.... 
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4. Enter the additional information about the Portuguese term. 
(Scroll down if necessary.) 
Write the Portuguese term in the “Term" field and change “Language" if necessary, to 
Portuguese. 

5. Then press Alt+SAlt+SAlt+SAlt+S (in Internet Explorer) or click on the green tick in the upper right-hand 
corner or click SaveSaveSaveSave. 

6. Press Alt+SAlt+SAlt+SAlt+S (in Internet Explorer) or SaveSaveSaveSave in the button field at the bottom of the window 
when you have finished updating the term record. 

UUUUndo changes in a term recordndo changes in a term recordndo changes in a term recordndo changes in a term record    

If you want to undo changes that you have made in a term record, click the cogwheel icon 

 (previously SettingsSettingsSettingsSettings)))), select the Show historyShow historyShow historyShow history checkbox and then click on the restore 
arrow  under RestoreRestoreRestoreRestore beside the earlier version of the term record which you want to restore. 
Other users with edit rights to the term record as well as system administrator and 
administrators can normally also cancel other users’ changes by restoring previous records.  
Notes! 
It is not possible to undo a change made using the RestoreRestoreRestoreRestore function described above.  
Furthermore, changes in concept relations and attached objects (including thumbnails) are not 
registered in the history and thus cannot be undone. 
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Add a cAdd a cAdd a cAdd a comment to omment to omment to omment to a term recorda term recorda term recorda term record        

All users (but guest users) can comment on existing term records, for example suggest additions 
and modifications, provide usage examples etc. (See also the Send feedback function, that can 
be used to send system- or dictionary-related email comments to the respective administrator.)  
 
Do as follows:  

1. With the desired term record in the result window, click the   
(or "n comments"n comments"n comments"n comments") link. 

2. Enter (type or paste in) your comment and click Save.Save.Save.Save. 

3. If you change your mind and do not want to save the comment, click the Cancel icon  in 
the upper-right corner of the comment dialog to close the dialog. (The dialog is also closed 
if you click another term in the term list.) 

4. If you want to remove your comment, click the dustbin icon on the same line as your 
comment. 

 
5. Please note that you may only remove your own comments, unless you are an administrator, 

who may remove the comments of all users: 
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Using Using Using Using multivalued multivalued multivalued multivalued fieldsfieldsfieldsfields    

If you want to select more than one attribute for a certain concept, you can use a multivalued 
field. Enter data in the following way: 
1. Ctrl-click the values (e.g. concept attributes) that apply  
2. Click the blue right-arrow to move the values to the SelectedSelectedSelectedSelected list  
3. Click Save Save Save Save to save the information (and Save Save Save Save again to save the concept). 
 

 
For import and export files, the format is comma-separated, for the example above: 
Asia, Europe, North America 
e.g.  
<descrip id="c263-f3" type="Lives in">Asia, Europe, North America</descrip> 
in a TBX export file. 
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Add or cAdd or cAdd or cAdd or chhhhange one or more term records using Grid View ange one or more term records using Grid View ange one or more term records using Grid View ange one or more term records using Grid View     
You can easily change or modify one or more term records, including the information on the 
concept level, by using the Grid View. One possibility offered by Grid View is reviewing a number 
of term records or terms, making necessary changes and then select to change the status of all 
(or a subset of all) reviewed term records e.g. to Approved or Rejected. 
You select a number of term records to put in Grid View, where they are available as drafts until 
you decide to save them.  
In short, the steps are:  
1. Select which term records to put in Grid View 
2. Open Grid View 
3. Edit the desired term records in Grid View 
4. Save the changed term records in the dictionary 
 

1) 1) 1) 1) Copying Copying Copying Copying term records to term records to term records to term records to the the the the Grid ViewGrid ViewGrid ViewGrid View    

If you want to add the current term record (that is displayed in the result window) to your grid 

view, click the Add Concept to Grid View icon  in the top right part of the screen. 
If you want to add all term records (from the main dictionary) with terms displayed in the term 

list to your grid view, click the Add All Terms in List to Grid View icon  below 
the term list. 
 

2) Going to the Grid View window2) Going to the Grid View window2) Going to the Grid View window2) Going to the Grid View window    

Proceed as follows: 

Click the Grid View icon  in the toolbar (or click Open Grid ViewOpen Grid ViewOpen Grid ViewOpen Grid View directly after having 
added the term records to the grid view) to display the selected term records. 
If you want to display more than 10 term records in the list, click the desired number (15, 20, or 
25): 

 
 

Otherwise, or for higher numbers of term records, you will have to page through the list using 
the page numbers or arrows:  

 
If you wish to hide certain of the concept-level fields and/or certain of the languages from the 

Grid View, click the Display SettingsDisplay SettingsDisplay SettingsDisplay Settings button:  

As an example, if you just want to view and work with the Definition and the French  
terms, unmark the tickboxes on the respective tabs as follows and click ApplyApplyApplyApply.  
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In the same way, unmark any "unwanted" term-level fields (for all displayed languages) on the 
Term Fields tab. 

3) Editing in Grid View3) Editing in Grid View3) Editing in Grid View3) Editing in Grid View    

1. Edit as desired. To change or add data in a certain field for a certain term record, just 
double-click the field, and then (for text fields), in the box that appears, type the text 

 
and then press TAB to save the text  
OR  
select a dropdown value  
OR  
select domain(s) for the term record.  
Please notePlease notePlease notePlease note that certain editing functions, like adding or editing attachments, relations and 
links, as well as adding or editing values for multivalued fields still has to be done for each 
term record, not from Grid View. Also, duplicity check is at present not active for term 
addition in Grid View. 
Important: It is a strong recommendation not to edit any fields containing internal or 
external links in Grid View. 
Also, please note that terms that you are allowed to change are displayed with black 
characters and terms that you are not allowed to change with grey characters. 
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If you wish to add another term to the term recordadd another term to the term recordadd another term to the term recordadd another term to the term record, right-click a term and either select Add Add Add Add NNNNew ew ew ew 
TTTTerm in [language of current term]erm in [language of current term]erm in [language of current term]erm in [language of current term] or select the language (German in the example) in the Add Add Add Add 
NNNNew ew ew ew TTTTerm inerm inerm inerm in dropdown. 
 

 
 
In the above menu, you can, if you have the necessary access rights, also delete the termdelete the termdelete the termdelete the term that 
you right-click. Just click Delete TermDelete TermDelete TermDelete Term and the term will be marked with a strikethrough in Grid 
View. 
In case you change your mind before you save the Grid view concepts, just right-click the term 
again and click Cancel Deletion:Cancel Deletion:Cancel Deletion:Cancel Deletion:    

 
In a similar manner, you can also change the language of the termchange the language of the termchange the language of the termchange the language of the term that you right-click. 
 

If you want to set a part of the term, like a trademark or product name, as non-translatable, 
please right-click and select Mark NonMark NonMark NonMark Non----translatable Parttranslatable Parttranslatable Parttranslatable Part. 
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Then, mark the term part not to be translated and click Mark:Mark:Mark:Mark: 

 
 
The part will then be marked as a signal to translators, in Grid View: 

 
and also in the normal result window view: 

 
Furthermore, if concepts are exported to Excel, e.g. for offline supplementation of translations, 
the non-translatable parts of the terms will be signalled to the translators with a contrasting 
color also in the Excel sheet: 

 
Technical note: In a TBX file, the syntax is the following: 
<term><hi translate="no">TermWeb</hi> Administrator and User Manual</term> 
If you want to change a value for more than one term recordchange a value for more than one term recordchange a value for more than one term recordchange a value for more than one term record, select these records and then 

click the EditEditEditEdit button.   
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(If you want to select all displayed term records in the Grid View before an action, tick the 
uppermost box.) 

 
 
2. Then  

a) select if the field is a concept-level or language term field,  
b) select the field,  
c) select the value and  
d) then click UpdateUpdateUpdateUpdate.... 

 
Another example, adding the same text to the Source field of all selected term records: 

 
Here, if you want to change a value or set a text for a term-level field for many term records, 
take care to see that terms exist for all the selected records for the language in question. 
If the bulk update gives an error when you try to save, a warning symbol will be displayed in the 
Concept ID column, and the erroneous field will display a red background (in this case the 
French term No. 2 field lacks a term if Noun is specified for the Part of speech field):  

  

 
If there are term records in the list that you do not need to edit, and want to remove from the 

list, click the Delete Draft icon.   
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If you want to delete more than one draft term record from the list, select the term records and 
then click the Delete DraftsDelete DraftsDelete DraftsDelete Drafts button. 
If you want to remove all term records from Grid View, click the Clear GridClear GridClear GridClear Grid button. 
(If you have modified any entry, you will get a warning.) Please note that this action will not 
delete the term record from the dictionary, just from the Grid View draft list. 
If you click the Delete ConceptsDelete ConceptsDelete ConceptsDelete Concepts button however, you may delete the selected term records from 
the dictionary (if allowed by your access profile). 

4) Saving the changed term records in4) Saving the changed term records in4) Saving the changed term records in4) Saving the changed term records in    the dictionarythe dictionarythe dictionarythe dictionary    

To keep all the draft Grid View entries with all changes that you have made and close the Grid 
View window, click the CloseCloseCloseClose button. You can open Grid View again at any time by using the 

 button. 

To save all changes that you have made to the draft Grid View entries in the dictionary, remove 
the changed records from Grid View and close the Grid View window, click the SaveSaveSaveSave button. 
Please note that you have to leave the last edited field for the changes to be saved and you to 
get the acknowledgement message "Concepts have been saved successfully". 

Merge term records (if other users have made changes to the same term records in the Merge term records (if other users have made changes to the same term records in the Merge term records (if other users have made changes to the same term records in the Merge term records (if other users have made changes to the same term records in the 
dictionary)dictionary)dictionary)dictionary)    

If another user has saved one or more term records from his or her Grid View (after you put the 
term records in your Grid View), when you save the term record(s) from your Grid View, the 
following symbol will show up at the lines of the changed term records. A message like this will 
also be displayed: "No concepts were saved. Concept 10 was changed by another user and needs 
to be merged before saving." OR, at the bottom of the window: "Cannot save drafts. Merge 
changes first". 

 
 
Then click the symbol (or select the remaining term records and click the MergeMergeMergeMerge button).  
A screen like the following will appear (for the first term record to merge): 
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The normal operation is to accept the value for the German and Finnish terms (saved to the 
database by other users after you put the term records in your Grid View) by selecting the Add Add Add Add 
TermTermTermTerm radio button and merging these with your French term by selecting Keep TermKeep TermKeep TermKeep Term. This applies 
for example when you create terms in one language and other users terms in other languages. 
Then click NextNextNextNext or Apply.Apply.Apply.Apply. 
(If more than one term record selected for merge, please click NextNextNextNext, otherwise, for the only or 
last term record to merge, click ApplyApplyApplyApply.)  
Then click SaveSaveSaveSave to save your changes along with the merged changes. 
 
Please note:Please note:Please note:Please note: In special cases, e.g. where you have no change or write access to other language 
terms, you might be presented with a white (empty) dialog box. Then just click ApplyApplyApplyApply to merge 
your changes with the saved changes of other users. 
. 
In case of conflict for the same field, please select if to use your Grid View value or the present 
value in the database.  

 
In this case, you have a better Czech translation (under another Term ID) in your Grid View, so 
you select the Skip TermSkip TermSkip TermSkip Term radio button and click NextNextNextNext or ApplyApplyApplyApply. 
Then click SaveSaveSaveSave to save the term record(s) in the database etc.  
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Another example, a conflicting value of the Definition field. Here, the grid value is selected: 

 

Summary: 

1) If the merge symbol ( ) turns up in your Grid View, this indicates another user has saved 
changes to the term record. 

 
2) Select these term records and click the Merge Merge Merge Merge button. 
3) Proceed as indicated above, selecting saved values or the best of the grid view or saved 
(database) value. 
Click SaveSaveSaveSave. 
 

Entering a new term record froEntering a new term record froEntering a new term record froEntering a new term record frommmm    within Grid Viewwithin Grid Viewwithin Grid Viewwithin Grid View    

If you want to create a new term record (concept) from Grid View, proceed as follows: 

1. Click AdAdAdAdd New d New d New d New ConceptConceptConceptConcept:  
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2. Enter data in the required fields: 

 
3. Perform any other changes to the term records in Grid View. 
4. Save the new (and changed) term records in the dictionary clicking Save.Save.Save.Save. 
5. Clear the grid and click CloseCloseCloseClose. 

General Grid View recommendationsGeneral Grid View recommendationsGeneral Grid View recommendationsGeneral Grid View recommendations    

Please note that you can only edit a term record in either the Grid View window OR in single 
term record editing mode (clicking Edit in the main TermWeb window). 
Please notePlease notePlease notePlease note:::: When you are done editing, make it a habit to always  
1) if the remaining term records need no later change: remove these records by clicking the 
Clear Grid Clear Grid Clear Grid Clear Grid button, 
2) close the Grid View by clicking the CloseCloseCloseClose button.  

Locking term records before editingLocking term records before editingLocking term records before editingLocking term records before editing    

As soon as you open a specific term record for editing by clicking the Edit concept icon, other 

users will see a "Locked by another" icon for that term record.        
If you want to lock a term record    for an entire session, before you start working with it in Grid 
View, e.g. when you intend to edit a group of related term records, please click the 
corresponding term in the term list to display the term record in the result window and then 

click the toggling Lock icon  in the top right part of the screen. The icon will change to 

Locked: .  

Then the term record will display a "Locked by another" icon  for other users until you log 
off or until you are done editing it. If any other user tries to edit the concept before that, the 
message "The concept is locked by another user" will be displayed for these users. When you save the 
record after editing, it will be unlocked automatically.  
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Setting source and target subtermsSetting source and target subtermsSetting source and target subtermsSetting source and target subterms    

In cases where you want to define pairs or sets of terms with common attributes, like style 
(level) within one concept, proceed as follows 

1. Enter the terms in the desired languages. 
2. Place the concepts in Grid View and open Grid View. 
3. Right-click one target term and select    Set Source TermSet Source TermSet Source TermSet Source Term. 

 

4. Select the desired source term and click SelectSelectSelectSelect: 

 
5. Proceed in the same way for other languages, and possibly for other concepts, and then click 

SaveSaveSaveSave to save the concept(s). 
6. The concept will then be displayed with the terms paired or grouped: 
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Add crossAdd crossAdd crossAdd cross----references, pictures and other objects to term recordsreferences, pictures and other objects to term recordsreferences, pictures and other objects to term recordsreferences, pictures and other objects to term records    
You can easily add a crosscrosscrosscross----referencereferencereferencereference from one of the text fields in the term record (excluding 
the term name field or fields that may only have numeric contents) to either a specific term 
record or to a term in a specific language. 
Right click on the field that you want to add a cross-reference to and choose Add Internal LinkAdd Internal LinkAdd Internal LinkAdd Internal Link. 
For example, type See also shaft, highlight the word shaft, right click and choose Add Internal Add Internal Add Internal Add Internal 
LinkLinkLinkLink.  
A search box is then opened and you can search for desired terms or term records in any 
language: 

  
(Note! This applies only to the sections in the dictionary to which you have access!) 
Search for the entry with the English term shaft and click on the desired term. 
Then choose if you want to create a link to the term record (concept) with the word shaft or the 
actual term itself ("Link is referring to" is linked to Concept or Term). Then click SaveSaveSaveSave.  
If you select Term(Static text), the link text will remain as is, even if the referred-to term is 
changed. If you select Term(Name), the link text will change if the referred-to term later is 
changed. In case you select the link to refer to a Concept, when the link is clicked, the term 
record is shown with the terms in the database’s order of languages. In case you select the link 
to refer to Term(Static text) or Term(Name), when the link is clicked, the term record is shown 
with the chosen term at the top. 
Note!Note!Note!Note! When making changes, the link is shown in double angle brackets, e.g. «link word». If you 
later want to change the link, select the link word including the angle brackets, right click and 
choose Edit linkEdit linkEdit linkEdit link. 
Note! Links should normally not be created for terms that are not approved. (Term records or 
terms should be marked with a status “Approved" or “Correct" if the dictionary offers a status 
option.) 
 
If you want to add a link tolink tolink tolink to an explanatory PDF image PDF image PDF image PDF image (or a    GIF GIF GIF GIF or    JPJPJPJPG imageG imageG imageG image)    of a term record, 
then save the picture in a picture archive, right click on the link text as in the instructions 
above, choose Add External LinkAdd External LinkAdd External LinkAdd External Link and copy to or type a link in the URL URL URL URL field. Finish by clicking 
SaveSaveSaveSave. 
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The link should be typed as a normal web link: 
http://www.my_terminology.com/graphics/figure.pdf.  
You can also add a link to a website in the same way:  
http://www.website.com 
 
If the administrator places all objects to be linked (picture, sound, video clip files etc.) in the 
TermWeb File repository, you can then easily create links from different term records to each 
object by selecting a text in a field, right clicking, selecting Add External LinkAdd External LinkAdd External LinkAdd External Link, if necessary 
displaying the file repository objects by clicking the File repository>>File repository>>File repository>>File repository>> button, double-clicking 
the desired object and then clicking Save.Save.Save.Save.    
    
To open the list of File repository objects, if not displayed: Click File Repository>>File Repository>>File Repository>>File Repository>>. 
To search for a File repository object: Enter any text string contained in the object’s file name 
(no asterisks needed here) and click SearchSearchSearchSearch. 
 
To prepare for this; as an administrator, to add files to the file repository, select Admin ViewAdmin ViewAdmin ViewAdmin View > 
File RepositoryFile RepositoryFile RepositoryFile Repository, click Add fileAdd fileAdd fileAdd file, browse to and select the desired file and, optionally, add a 
description of the file. Then click Create fileCreate fileCreate fileCreate file. 
To view (or play) the file, click View fileView fileView fileView file.  
It is also possible to upload files in batch to and download files in batch from the file repository: 
 
To upload files in batch to the file repository, click Import files from a zipImport files from a zipImport files from a zipImport files from a zip    filefilefilefile, browse to and 
select the ZIP file containing the objects, and then click ImportImportImportImport. The ZIP file will be 
automatically uploaded and the objects unpacked into the file repository. 
To download files in batch from the file repository to a ZIP file, e.g. for backup purposes, click 
Export all files in repository to zip fileExport all files in repository to zip fileExport all files in repository to zip fileExport all files in repository to zip file. You will then be able to save the ZIP file in a selectable 
directory in your computer or network. 
 
If you wish to attach a documentattach a documentattach a documentattach a document to the TermWeb concept (to display an image or another 
binary object, e.g. a PDF file), optionally write any text that is to be shown before the object 
symbol (or illustration thumbnail), right click in the field where to display the object, click Add Add Add Add 
AttachmentAttachmentAttachmentAttachment, indicate the text that is to be shown when someone points to the object symbol in 
the field Display nameDisplay nameDisplay nameDisplay name and browse to the field or copy the link to the file that you want to read 
into the database to the File to attachFile to attachFile to attachFile to attach field.  
In this case the object is saved in the internal TermWeb database. 
Example of object symbols: ,  

 
To remove a file that has been attached according to the instructions above, do as follows: 
1. Edit the term record and right click on the image field in question. 
2. Choose Edit AttachmentsEdit AttachmentsEdit AttachmentsEdit Attachments. 
3. Click Delete Delete Delete Delete on the line of the file in question and confirm. 
4. Save the field in question and the term record (press Ctrl+SCtrl+SCtrl+SCtrl+S twice). 
 
If you want to replace a file that was attached according to the instructions above or add an 
informative text to be shown when you point to the object symbol: 
1. Edit the term record and right click on the image field in question. 
2. Choose Edit AttachmentsEdit AttachmentsEdit AttachmentsEdit Attachments. 
3. Click Edit Edit Edit Edit on the line of the file in question. 
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4. Indicate any “display text" for the file (the object) in the Display nameDisplay nameDisplay nameDisplay name field and/or new 
object in the field Replace with fileReplace with fileReplace with fileReplace with file. 

5. Click SaveSaveSaveSave. 
6. Save the field in question and the term record (press Ctrl+SCtrl+SCtrl+SCtrl+S twice). 

Show a picture that is associated with a term record Show a picture that is associated with a term record Show a picture that is associated with a term record Show a picture that is associated with a term record     
Some term records include links to web sites, explanatory images or other multimedia objects. 
In these cases a link with a different color or possibly text with a small image symbol is visible 
in the relevant field.  
When you click on one of the latter, the picture will be shown in a new window. 
Close the window with the picture by clicking the 'x' in the upper right-hand corner (or on the 
Close tab symbol or corresponding for tabbed browsing). 
 
Alternatively to symbols, thumbnails can be displayed (for attached jpg and gif illustrations): 
To show illustration thumbnails:  

Click the cogwheel icon  (previously Settings)Settings)Settings)Settings) and check the ShoShoShoShow thumbnails w thumbnails w thumbnails w thumbnails box. 
 
To hide illustration thumbnails and show object symbols only: 

Click the cogwheel icon  (previously Settings)Settings)Settings)Settings)    and deselect the Show thumbnailsShow thumbnailsShow thumbnailsShow thumbnails 
checkbox. 
 
Attached images (shown as symbols or thumbnails) as well as links to images in the File 
repository are shown/expanded when the symbol, thumbnail or link is clicked. Then the image 
will be shown "floating", i.e. can be moved around in the result window as desired. Just click 
again to restore to the original view. 
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Creating and displaying Creating and displaying Creating and displaying Creating and displaying relationsrelationsrelationsrelations    
TermWeb allows you to define, edit and view relationships like subset, part-of, etc. for the 
concepts in your dictionary. Concept relations are also displayed graphically in a navigable map 
to let you find and view the related concepts in an easy way. The terms in the relation graphs 
are displayed in the currently selected source language. 
 

To display relations, click the cogwheel icon  (previously Settings)Settings)Settings)Settings)    and check the Show Show Show Show 
relations relations relations relations checkbox. 

 
To view a diagram of the current concept’s relations, click Show graph Show graph Show graph Show graph »»»». 
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Here, click View conceptView conceptView conceptView concept to go back to normal view. 
You define and delete relations under Add/EditAdd/EditAdd/EditAdd/Edit > Edit concept level fields Edit concept level fields Edit concept level fields Edit concept level fields     
If you click Add relationAdd relationAdd relationAdd relation, a list of terms is displayed. Find and select the term you want to create 
a relation to. Then define which relation the selected new term has to the concept you started 
out working with.  
An example: If you start out working with the concept chassis, click Add relation, find the car 
concept and define the relation as Partitive and Superordinate, as car is superordinate to 
chassis.  
If you want to create a specific label for the chosen type of relation, you can fill in the 
SpecificationSpecificationSpecificationSpecification field as in the following example:  
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That specific information will then be shown when the mouse is hovered over the relation arrow 
in the result window:  

 
 or in the left pane of the concept relation graph: 

 

Print term data Print term data Print term data Print term data     
To print a selected subset of term data, either to a PDF file or to a printer, proceed as follows: 
1. Display the desired list of terms, using search criteria, filters etc.  
2. In the Search view, click the PrintPrintPrintPrint icon. 
3.3.3.3. Now you can select whether to print only the concept currently displayed in the result 

window, or all concepts in the term list. Also, you can select to print to your standard printer 
(via html) or to a PDF file.  
In case you select normal (html) printout with the Print only the selected conceptPrint only the selected conceptPrint only the selected conceptPrint only the selected concept or Print Print Print Print 
all concepts in the current listall concepts in the current listall concepts in the current listall concepts in the current list radio button, you can choose to save the html file for later 
use. 
Furthermore, you can choose to add a list of contained concept ID numbers at the top of the 
printout by selecting Create a table of contentsCreate a table of contentsCreate a table of contentsCreate a table of contents.    

 
Please note that the fields appearing in the printout depend on the view used for your user 
group. Also, not all installations allow term printout. 
 

Check the history of a term recordCheck the history of a term recordCheck the history of a term recordCheck the history of a term record    
To show a list of all the important changes made to a term record: 
4. Show the term record. Click on the term from the list so the content of the term record is 

visible in the result pane. 

5. Click  (previously SettingsSettingsSettingsSettings) and select the Show history Show history Show history Show history box. An overview of 
changes made to the term record will appear. 
Click the link text under Action, e.g. "The concept was changed" if you want to see more 
information about the change. 

6. Deselect Show historyShow historyShow historyShow history when you want to hide the information. 
 
See also Undo changes in a term record. 
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What is a dictionary?What is a dictionary?What is a dictionary?What is a dictionary?    
A dictionary is a major part of the database of a given structure, e.g. a limited number of 
languages and fields. 
The fields may be valid for the entire term record (concept level fieldsconcept level fieldsconcept level fieldsconcept level fields), e.g. a definition. The 
fields may also be valid only for terms (term fieldsterm fieldsterm fieldsterm fields); used to specify e.g. grammar or source of a 
translation of a term in a particular language (a term equivalent).  
The administrator defines dictionaries. You specify which dictionary will be shown by clicking 
the scroll arrow beside the Dictionary Dictionary Dictionary Dictionary dropdown and choosing the dictionary from the list. The 
list of terms in the chosen source language is then updated. 
More than one dictionary:More than one dictionary:More than one dictionary:More than one dictionary:    
There is possibly more than one dictionary available to you. In this case, you can either change 
which dictionary to view, search, and work with, as described above, OR select one ore more 
additional dictionaries to view and search in the same time as the main dictionary. 
Note!Note!Note!Note!    
You should only add, change, and delete concepts in the currently selected main dictionary. 

Selecting additional dictionariesSelecting additional dictionariesSelecting additional dictionariesSelecting additional dictionaries    

If there are more than one dictionary available, you can select one or more dictionaries (besides 
the main dictionary selected in the Dictionary dropdown) to search in. These are referred to as 
additional dictionaries and are also selected in the same window as sections. 

1. Click the "All sections …" link or the < Change< Change< Change< Change button (to the right of the Dictionary 
dropdown). 

2. Press and hold Ctrl and click the additional dictionaries you wish to select for searching. 

3. Click the SelectSelectSelectSelect button. The number of additional dictionaries is displayed in the link text 
and the term list is updated to include terms from selected additional dictionaries. Terms 
from additional dictionaries are displayed with pink background in the term list. 

Searching in additional dictionaries has some limitations compared to main dictionary 
searching:  

• Terms from all available sections are displayed from additional dictionaries. 

• Domain, filter and multi-field searches only return terms from the main dictionary. 

• Fuzzy search returns matches from main and additional dictionaries. 

• Editing of concepts is only possible in the main dictionary. 

When a concept from an additional dictionary is displayed in the result window, a message is 
shown at the top of the window with a link for setting the concept's dictionary as main 
dictionary. This provides a quick way of changing the main dictionary if you for example want to 
edit the concept. The previous selected main dictionary is automatically selected as additional 
dictionary when this link is used.  

If you change the main dictionary using the Dictionary dropdown, the previous main dictionary 
is notnotnotnot selected as additional dictionary.  
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What is a section?What is a section?What is a section?What is a section?    
A dictionary can contain a number of sections with various types of terms and phrases. For 
instance, there might be a section with terms that are still being worked on, one with 
abbreviations and acronyms, and one with approved terms that are standard in various 
languages.  
If you click on the "All sectionsAll sectionsAll sectionsAll sections    …………" text, you will see all of the sections (and possibly additional 
dictionaries) that are available to you. 
You can choose to show terms from one or more of the sections: 
1. Click the < Change< Change< Change< Change button (or click the text, normally "X of Y sections …X of Y sections …X of Y sections …X of Y sections …", to the right of the 

Dictionary dropdown). Usually the text “All sections All sections All sections All sections …………" is shown here. 
2. A list of available sections appears in a box in the result pane. Select the section that you 

want to search. Hold CtrlCtrlCtrlCtrl and select other sections that you want to search. 
3. Click SelectSelectSelectSelect. (Note that the term list gets a yellow background to signal that only terms from 

a subset of the available sections are displayed.) When you then click the < Change< Change< Change< Change button 
again, the names of the sections which you have selected appear in the Selections for Selections for Selections for Selections for 
searchingsearchingsearchingsearching box in the result pane. 

 
If you want to show terms from all the sections in a dictionary: 
1. Click the < Change< Change< Change< Change button (or click the text, normally "X of Y sections …X of Y sections …X of Y sections …X of Y sections …", to the right of the 

Dictionary: dropdown). 
2. Click the word "AllAllAllAll" (Select AllAllAllAll) in the Sections in current dictionarySections in current dictionarySections in current dictionarySections in current dictionary part of the SeSeSeSelelelelections ctions ctions ctions 

for searching for searching for searching for searching box. 
3. Click the Select Select Select Select button at the bottom of the dialog box. 

Show a particular domain or subdomainShow a particular domain or subdomainShow a particular domain or subdomainShow a particular domain or subdomain    
The terminological entries in a dictionary and its sections can be classified according to their 
subject areas, i.e. domains, such as DATA PROCESSING or BUSINESS & ADMINIST.  
If you want to only show terms from a single domain or subdomain: 
1. Tick the Domain search Domain search Domain search Domain search box.  

In order to show as much of the domain selection frame as possible, you can switch to full 
screen view (F11 in Internet Explorer). 

2. Select the desired domdomdomdomain(s).ain(s).ain(s).ain(s). If you select a domain, its subdomainssubdomainssubdomainssubdomains are also selected 
automatically. To select or remove subdomainssubdomainssubdomainssubdomains, first click the plus sign to the left of the 
main domain selected and then the subdomain(s)which you want to select. 
Click OKOKOKOK at the bottom of the result pane when you are finished. 

3. Only terms from the selected domains/subdomains will be visible in the chosen source 
language. 

You can see which domains and subdomains you have chosen in when you point to the heading 
[n] selected domains [change][n] selected domains [change][n] selected domains [change][n] selected domains [change] at the top of the result pane. 
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Move a term recordMove a term recordMove a term recordMove a term record    
To move a term record: 
1. Show the term record. Click on the term from the list so the content of the term record is 

visible in the result pane. 

2. Click the Edit Edit Edit Edit icon . 
3. Press Alt+OAlt+OAlt+OAlt+O (in Internet Explorer) or click on Edit concept level fields...Edit concept level fields...Edit concept level fields...Edit concept level fields.... 
4. Choose a different section from SectionSectionSectionSection box and press Alt+S Alt+S Alt+S Alt+S (in Internet Explorer) or click 

SaveSaveSaveSave at the bottom of the window when you are finished. 
5. Save the term record by clicking SaveSaveSaveSave. 

Remove a term record Remove a term record Remove a term record Remove a term record     
To remove an entire term record (e.g. a duplicate entry):  
(You can also remove a term record from its current place by moving it to a "hidden" section for 
removed records by following the instructions under “Move a term record".) 
1. Show the term record. Click the term on the list so the content of the term record is visible 

in the result pane. 

2. Click the Delete Delete Delete Delete icon . 
3. Confirm that you wish to remove a term record by clicking DeleteDeleteDeleteDelete    in the text box shown. The 

term list is updated. 
 

Remove a termRemove a termRemove a termRemove a term    
You can remove a term equivalent from a term record as follows: 
1. Show the term record. Click on the term in the list to the left so that the content of the 

term record is visible in the result pane. 

2. Click the Edit Edit Edit Edit icon . 
3. Click once on the term you want to remove so that it is appears at the top of the result 

pane. 

4. Click Delete term Delete term Delete term Delete term  to confirm that you want to delete the term. 
(If you change your mind, press Alt+XAlt+XAlt+XAlt+X (in Internet Explorer) or click CancelCancelCancelCancel in the button 
field at the bottom of the window. You can also later use the Restore function in Show 
history.) 

5. Press Alt+SAlt+SAlt+SAlt+S (in Internet Explorer) or click SaveSaveSaveSave in the button field at the bottom of the 
window when you have finished updating the term record.  
The term list is updated. 
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Import and export term dataImport and export term dataImport and export term dataImport and export term data    
If allowed by the administrator, even if you are not an administrator, you may have the right to 
import and/or export data to and from certain sections of a dictionary. Please refer to sections 
“Import: To import term data” and “Export: To export term data” below. 

Send feedbacSend feedbacSend feedbacSend feedbackkkk        
This is how you send a message to the system administrator or the dictionary administrator: 
(To save a comment with a specific term or term record, please use the Add comment function.) 
 
1. Click on the mail symbol . 
2. Select the name of the addressee from the dropdown in the ToToToTo field. 
3. Your name and email address should already be filled in (if registered by the administrator). 

Otherwise, fill in these together with the subject and your message. You can also attach a 
file with additional information. (Attach). 

 
4. Click Send.Send.Send.Send. Confirmation that the message has been sent appears in the result pane. 
 

Log outLog outLog outLog out    
Click Log outLog outLog outLog out in the upper right-hand side of the window. 
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Administration Administration Administration Administration     (for administrators only)(for administrators only)(for administrators only)(for administrators only)    
 
If you click the AdminAdminAdminAdmin icon in the search mode (with search field, term list and result pane 
visible) the following function icons will appear: 

� New Dictionary WizardNew Dictionary WizardNew Dictionary WizardNew Dictionary Wizard: Create/add a new dictionary 
� DictionariesDictionariesDictionariesDictionaries: Modify or remove a dictionary (languages, fields, layout), copy a dictionary, 

export a dictionary definition and create a new dictionary elsewhere by importing it 
� SectionsSectionsSectionsSections: Add, rename and delete sections 
� HistoryHistoryHistoryHistory: View changes in the overall structure and content of a dictionary and “undo” 

the ones you do not want. If you want to “undo” changes (i.e. restore previous data) for 

a specific term, go to Search View > click the cogwheel icon  (previously 
Settings)Settings)Settings)Settings) > Show history. 

� Edit DEdit DEdit DEdit Domainsomainsomainsomains: Add, edit and delete domains and subdomains 
� SubclassesSubclassesSubclassesSubclasses: Add, edit and delete subclasses (groups of term records that can be located 

in different sections and are viewed in a certain way by all users, except administrators.) 
� Edit ViewsEdit ViewsEdit ViewsEdit Views: Add, change and remove views for a specific dictionary. Different views, such 

as differences in the information that is visible, can be selected for different user groups. 
Different views can be used, for example, to hide fields with exclusively administrative 
information from most users, except terminologists and administrators. 

� ImportImportImportImport: Import data with variable formats into TermWeb 3 
� ExpoExpoExpoExportrtrtrt: Export a complete dictionary or a (filtered) part of a dictionary 
� File Repository:File Repository:File Repository:File Repository:    Work with objects like pictures, sound files, etc. in the internal TermWeb 

file repository, import and export objects in batch 
� Users:Users:Users:Users: Add, modify, deactivate/activate or delete a user 
� Groups:Groups:Groups:Groups: Add, modify and delete groups (with any filters and views) 
� Group Members:Group Members:Group Members:Group Members: Assign the user to one or more groups. 
� Guest AccountGuest AccountGuest AccountGuest Account: Activate/deactivate a guest account (for several simultaneous users 

without personal user names). Indicate automatic login or normal login to be associated 
with a guest user name and password. 

� Change Password:Change Password:Change Password:Change Password:    Change your own password 
� Access Editor:Access Editor:Access Editor:Access Editor: Select the level of user group(s’) access (no access, read access or read 

and write access) as well as export/import rights to various dictionaries and sections 
� Permission Schemes:Permission Schemes:Permission Schemes:Permission Schemes: An alternative to Access Editor, providing a more detailed 

configuration of access permissions, including delete rights, and easier management.  
A permission scheme consists of a set of permissions granted for different user groups. 
The scheme is assigned to selected dictionaries and/or sections. 

� Lock Languages:Lock Languages:Lock Languages:Lock Languages: Select (for each applicable dictionary) which languages should not be 
editable for members of certain user groups 

� LanguageLanguageLanguageLanguage    ReplaReplaReplaReplacececece:::: Move terms between languages and sublanguages. As an example, 
you can move (redefine) all generic terms in a certain language to a specific 
geographical (region) or orthographical (script) variant of the language or vice versa. 

� Scheduled Jobs:Scheduled Jobs:Scheduled Jobs:Scheduled Jobs:    Automate regular exports of terminology data that fulfill criteria. 
� Statistics:Statistics:Statistics:Statistics:    View usage (user login) statistics for the installation, listed per client, user etc. 
� Workflows:Workflows:Workflows:Workflows:    Define and automate tasks, control access permissions on the field level, and 

add condition-dependent styling to your term data. 
� Administrator Tools:Administrator Tools:Administrator Tools:Administrator Tools:    Reindex dictionaries to speed up access. Convert old static internal 

links to terms (cross-references) to dynamic links (reflecting any change in referred-to 
terms). Customize message for error page. Specify password requirements. 
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� ProjectsProjectsProjectsProjects::::    Define and automate certain project-related tasks, including defining filters 
and workflows 
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� ClientClientClientClient    InfoInfoInfoInfo: Here, you get information on login name, possible API key (to be stated in 
TermWebIntegrator products), total number of active users, maximum number of user 
accounts, maximum number of individuals who can be logged in at the same time, and, 
if enabled, the maximum number of concurrent guest users.    

    
� ClientsClientsClientsClients    (can only be used by the system administrator): Add, modify or delete clients. 

Specify a maximum number of user accounts and/or a maximum number of individuals 
who can be logged in at the same time for each client, and, if enabled, a maximum 
number of concurrent guest users.    

� LicenseLicenseLicenseLicense    Here, you enter your license key that you receive at installation time, to activate 
your defined number of user licenses.    

� Batch Search Tool:Batch Search Tool:Batch Search Tool:Batch Search Tool:    Search a dictionary for existence of a batch of terms, e.g. before an 
import of new data. This function is normally available for all users. See section Check 
for existing terms in a dictionary – Batch Search Tool.    

� API TemplatesAPI TemplatesAPI TemplatesAPI Templates    Here, you create templates to be used by different customers, stating 
what dictionary/dictionaries (or section/sections) to use for lookup and possible term 
suggestions e.g. for different customers in the TermWebIntegrator for XTM Cloud 
product. 

.    
Note! Note! Note! Note!  

� You can always return to the window with all the administrator function icons by 
clicking Admin ViewAdmin ViewAdmin ViewAdmin View in the upper left-hand side of the window. 

� You can always return to search view by clicking Search ViewSearch ViewSearch ViewSearch View in the bar to the left of 
Admin View link. 
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New Dictionary Wizard: Add a new dictionaryNew Dictionary Wizard: Add a new dictionaryNew Dictionary Wizard: Add a new dictionaryNew Dictionary Wizard: Add a new dictionary    
Note that a section with the same name as the dictionary is always created as a dictionary is 
created. Note also that authority to access a dictionary and its sections is always initially set as 
Undefined if Access Editor is used. You need to define the Users and User groups and their 
authority if you want to limit access to a dictionary. In case Permission Schemes is used, the 
Default Permission Scheme will be applied to the new dictionary. 

Dictionaries: Edit/deletDictionaries: Edit/deletDictionaries: Edit/deletDictionaries: Edit/deleteeee/empty/empty/empty/empty    dictionarydictionarydictionarydictionary, export/import dictionary definitions, export/import dictionary definitions, export/import dictionary definitions, export/import dictionary definitions    
To work with your dictionaries, go to AdminAdminAdminAdmin > DictionariesDictionariesDictionariesDictionaries.  
You will see a list of dictionaries with the present number of concepts and other data and 
options for the dictionary. Please note that the DeleteDeleteDeleteDelete (delete both dictionary structure and 
contents) and EmptyEmptyEmptyEmpty (delete only dictionary contents while keeping the structure) functions are 
irreversible. For the CopyCopyCopyCopy function, please refer to section Create a copy of an existing 
dictionary. To editediteditedit a dictionary as described below, just click the dictionary name. 

 
Important noteImportant noteImportant noteImportant note: When you have added or edited a language or field, click SaveSaveSaveSave for the language 
or field and then click Save ChangesSave ChangesSave ChangesSave Changes in the Dictionary data screen. 
You can rename a dictionary as well as the language, concept and term level fields by first 
clicking the dictionary name. Here, you can also define at which place the dictionary should be 
placed in the list of dictionaries (dictionary selector etc.). Type the desired order number in the 
Sort indexSort indexSort indexSort index field. Note that this has to be done starting at number 1, and preferably for all 
dictionaries in the database. 
Furthermore, you can define the dictionary administrator (in the Email recipient field; see also 
the "Send feedback" section), You can also change the order between languages, concept-level 
fields and term-level fields in the dictionary, and also, as an example, the order between values 
in picklist and multivalue fields; custom order (move selected value up or down) or alphabetic 
order: 

 
 
Important noteImportant noteImportant noteImportant note for creating a value set for a multivalued field: It is recommended to create 
non-overlapping values, as this simplifies the task of creating filters including the values. 
As an example, rather than projA and projA1 etc. as values, use projA and projB etc. 
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Please note that you can create a value set for a multivalued field in the following way: 
1) Create a dictionary with the multivalued field-to-be defined as a text field. 
2) Import the desired term records including multivalued field-to-be values. 
3) Go to AdminAdminAdminAdmin > DictionariesDictionariesDictionariesDictionaries and click the desired dictionary. 
4) Select the field and click EditEditEditEdit. 
5) Change the Field type to Multivalued. 
6) Click the Generate...Generate...Generate...Generate... button. 

 
7) Click SaveSaveSaveSave to save the field settings. 
8) Click Save changesSave changesSave changesSave changes to save the dictionary structure. 
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Languages:Languages:Languages:Languages: 
For each language you choose to add to a dictionary (from a list of all languages, common 
languages of the world, or European Union languages), you can select to specify the following: 

• Possible geographical variants; regions (either predefined like US English, UK English, 
etc. or user-defined) 

• Possible orthographical variants; character sets (like traditional and simplified Chinese 
scripts) 

• If the language (or language variant) is written from left to right or right to left 
 

 
 
The "language" Not applicableNot applicableNot applicableNot applicable can for example be used for manual numeric concept or item 
numbering or for lists of terms or acronyms common to more than one language. If a dictionary 
only containing "Not applicable" language terms is selected as main dictionary with another 
secondary dictionary, searches will present results from a) the main dictionary and b) terms 
from the first language in the additional dictionary in the term list. If a "normal" dictionary is 
selected as main dictionary with a secondary dictionary only containing "Not applicable" 
language terms, searches will present results from a) current source language terms of the main 
dictionary and b) terms from within the set of "Not applicable" language terms in the term list, 
(irrespective of currently selected source language).  
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Field types:Field types:Field types:Field types: 
You can create single-line and multi-line text fields, date fields, incremental fields (the value of 
which is automatically recalculated for each new term record), as well as picklist fields 
(allowing the selection of one of several fixed values) and multivalued fields (allowing the 
selection of one or more of several fixed values): 

 
A multivalued field "Product(s)" with several values selected could for example be displayed as 
follows: Product A, Product C, Product D, Product V.Product A, Product C, Product D, Product V.Product A, Product C, Product D, Product V.Product A, Product C, Product D, Product V.    Please note that values in multivalued field cannot 
contain the separator character , (comma). 
Also, to simplify later filtering on the values, preferably avoid partly overlapping values like 
projA and projA1! 
Character encoding, mandatory fields and min/max no. of characters allowed:Character encoding, mandatory fields and min/max no. of characters allowed:Character encoding, mandatory fields and min/max no. of characters allowed:Character encoding, mandatory fields and min/max no. of characters allowed: 
You can also indicate how character encoding of data, whether or not fields are mandatory, and 
the kind of data permitted in the field (see below) as well as the min./max number of characters 
allowed.  
If Unicode is selected for a field, then it is possible to write or copy in characters other than the 
Latin as well special characters, such as a dash. Note that the term field (in all languages) is 
specified as Unicode. 
Mandatory fields are indicated by an asterisk. If you try to save a term record without filling in a 
mandatory field, an error message will appear and/or the field will be indicated with a colored 
background. 
Data type (Allowed value):Data type (Allowed value):Data type (Allowed value):Data type (Allowed value): 
In addition you can indicate what kind of data is allowed in the field, i.e. any text, integer 
number (without a decimal or comma to indicate thousands, max 9 characters), or data that 
corresponds with a regular expression. An example of the latter is the simplest form of syntax 
control of the date, i.e. 20YY-MM-DD: 
20\d{2}(-)((0[1-9])|(1[0-2]))(-)((0[1-9])|([1-2][0-9])|(3[0-1])) 
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If you want to add your own definition of a field on the concept level, with a limited number of 
possible values, do as follows: 

1. Click the dictionary’s name. 
2. Click Add...Add...Add...Add... in Concept Level Fields. 
3. Select New custom fieldNew custom fieldNew custom fieldNew custom field and then click ContinueContinueContinueContinue. 
4. Enter the field name. 
5. Specify the type of field in Field typeField typeField typeField type (Picklist). 

Note! A single-line field can theoretically contain a maximum of 16,383 characters, but 
as the name indicates it is intended for less information, e.g. a maximum of about 70 
characters which can be shown on one line in the result window without sideway 
scrolling. 
A multi-line field can contain a maximum of 16,383 characters, if not otherwise 
specified under Data length limit. 

6. Select LatinLatinLatinLatin----1111 in EncodingEncodingEncodingEncoding if the field only will include Latin-1 characters. 
7. Select Value is requiredValue is requiredValue is requiredValue is required if the field must be given a value when a term record is created. 
8. Click Add...Add...Add...Add... beside the box for "Picklist items". 
9. Enter one of the fixed values in the typing field and click SaveSaveSaveSave beside the typing field. 
10. Repeat step 9 for other possible values. 

Note that the value you write in first will be shown at the top of the list.  
If necessary you can move the various values up or down in the list. 
If the field is defined as mandatory, then the upper value of the list will be filled in 
automatically when someone creates a new term record. 

11. Click SaveSaveSaveSave at the bottom of the box. 
12. Click Save ChangesSave ChangesSave ChangesSave Changes if you do not want to add or change more fields. 

Important:Important:Important:Important: An alternative and often quicker method to prepare for already existing data is to 
create the field as a single-line field, import the data into the field and then change the field to 
Field type Picklist, and click Generate...Generate...Generate...Generate... under Generate picklist from existing values Generate picklist from existing values Generate picklist from existing values Generate picklist from existing values before 
saving the field and dictionary definition. 
 
Note 1: Initial zeros in numeric fields are automatically truncated when the term record is 
saved. 
Note 2: Fields intended for numeric values or integer numbers longer than 9 characters should 
be defined as single-line or multi-line fields with "Any text" allowed, and for import of data into 
such a field from Excel, these values should be preceded by an apostrophe and formatted as text 
in the Excel file, for the numeric data to be interpreted and imported correctly. 
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Export a dictionary definitionExport a dictionary definitionExport a dictionary definitionExport a dictionary definition    

This is how to create a file with all information on the structure of an existing dictionary 
(languages, fields and sections, and, optionally, layout and/or filter definitions), e.g. for use on 
another TermWeb installation or client: 

1. Click DictionariesDictionariesDictionariesDictionaries. 
2. Click Export Export Export Export beside the dictionary from which you want to export the definition.  

Then select the export format and details in the following dialog: 

 
3. Save the resulting XML file in an appropriate location and with an appropriate name. 

Note!Note!Note!Note! Only the dictionary structure is exported, no term data, user data, view data or 
access rights (permission schemes) data is exported. However, user and group data can 
be exported using the Export all users and groups to fileExport all users and groups to fileExport all users and groups to fileExport all users and groups to file option on the Admin > Users or 
Admin > Groups dialog. 

Import a dictionary definiImport a dictionary definiImport a dictionary definiImport a dictionary definitiontiontiontion    

Important noteImportant noteImportant noteImportant notessss: If you want to create an identical copy of an existing dictionary, with or 
without term data, in the same TermWeb installation and client, use the Copy dictionary 
function, see the section Create a copy of an existing dictionary. 
It is also possible to create a dictionary structure and import the data in one step by importing 
an earlier exported dictionary data file (or a correctly structured import file). Then TermWeb will 
recreate the structure. See the section Quick import in the chapter "Import: To import term 
data".  
Otherwise, this is how to create a new empty dictionary with the same structure (languages, 
fields and sections, and, optionally, layout and filter definitions) as one which you have 
previously exported: 

1. Click DictionariesDictionariesDictionariesDictionaries. 
2. Click BrowseBrowseBrowseBrowse and choose an exported dictionary definition file from the Import Import Import Import 

dictionary definition from file dictionary definition from file dictionary definition from file dictionary definition from file box.... 
3. Click Import dictionaryImport dictionaryImport dictionaryImport dictionary, select Create new dictionaryCreate new dictionaryCreate new dictionaryCreate new dictionary and select whether to import also 

layout and filter definitions. Then click Import dictionaryImport dictionaryImport dictionaryImport dictionary, and a dictionary with the same 
languages, fields and characteristics as the previously exported dictionary is created.  
If you import the dictionary definition while logged on to the same TermWeb site and 
client that created the original dictionary, the new dictionary will have the same name 
as the exported dictionary definition but with an added number, e.g. (2). 
Note! Note! Note! Note! Term information is not imported, but you can import it via (Export and) Import in 
Admin View. 

Alternatively, you can choose to import filters and/or layout from the selected dictionary 
definition file into an existing dictionary by selecting Import to existing dictionaryImport to existing dictionaryImport to existing dictionaryImport to existing dictionary and then 
clicking Import dictionaryImport dictionaryImport dictionaryImport dictionary:::: 
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If you want to recreate the structure of a dictionary from an earlier exported dictionary data file 
(or a correctly structured import file in Excel or TBX format), you can choose the Quick import 
option from the AdminAdminAdminAdmin > ImportImportImportImport screen (see page 59 below). This will both create the structure 
(dictionary definition) and import the term data into the dictionary. 

Edit dictionary layoutEdit dictionary layoutEdit dictionary layoutEdit dictionary layout    

If you want to change the appearance (character size, color etc.) of the field names and/or text, 
please do as follows: 

1. Click DictionariesDictionariesDictionariesDictionaries. 
2. Click Edit LayoutEdit LayoutEdit LayoutEdit Layout on the line of the relevant dictionary. 
3. Change the style parameters as desired. 

 
(Here, you can also import a MultíTerm XDL file if you wish to create a similar layout as defined 
in such a file.) 
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An example of a CSS file (Cascading Style Sheets, that decides the appearance of the 
terminology display window): 
/* $Date: 2007/04/05 15:01:44 $ */ 
span {font-family:verdana;font-size:11px} 
br {display:none} 
div {text-align:left} 
div.t {margin:10px 0} 
.l {white-space:nowrap} 
.d {margin-left:1em} 
.d br {display:inline} 
.I_dom .l {display:block;float:left} 
.I_dom .d {display:block;float:left;margin-left:5px} 
.md {background:#eef;padding:.2em .4em} 
.md .d {white-space:nowrap} 
.md .f {display:inline;margin-right:20px} 
.md .f span {font-size:9px} 
.md .f .l {color:#99d;font-weight:bold} 
 
.cf {display:block;margin:20px 0} 
.cf .f{display:block;font-weight:bold} 
.cf .f .l {color:#99d} 
.cf .f .d {color:#999} 
 
.f .l {color:blue;font-weight:bold} 
.f {display:block} 
 
.t,.tc {text-align:left} 
 
.tx * {margin-left:20px} 
.tx .t {margin-top:0} 
.tx .md {margin:1em 0 0 40px} 
.tx .md * {margin-left:0} 
.tx .md .d {margin-left:1em} 
.tx a, .tx img {margin-left:0} 
.tx .ILANG {display:block} 
.tx .ILANG .d {font-size:13px} 
.tx .ITERM .d {font-size:15px;font-weight:bold} 
 
 
.tc {display:table} 
.tc .t {margin:.2em 0;display:table-row} 
.tc .ILANG {display:table-cell} 
.tc .ITERM  {display:table-cell} 
.t .ILANG .l {display:none} 
.t .ILANG .d {font-weight:bold;color:red} 
.t .ITERM .l {display:none} 
Note!Note!Note!Note!    
You can always revert to the original layout for the dictionary at any time by clicking Use Use Use Use 
Default CSS.Default CSS.Default CSS.Default CSS. 

Color of field 
labels (acc. 
to CSS color 
names) 

(Font and) 
font size of 
displayed data 

Color of 
language 
names 
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Sections: Working with sectionsSections: Working with sectionsSections: Working with sectionsSections: Working with sections    
Go to AdminAdminAdminAdmin > SectionsSectionsSectionsSections  

 

This is where you can add, modify and delete sections as well as purge the contents of a section. 
You also can see the current number of concepts in each section. 
Please note that you can sort the list (in ascending or descending order) by section name, 
dictionary name, number of concepts, creation date or modification date by clicking the 
respective heading  
If you wish to merge the contents of two sections into one, place the concepts of the section to 
be deleted in Grid View, batch-change the section of all these concepts to the new section and 
click Save. Then go to AdminAdminAdminAdmin > Sections Sections Sections Sections and    delete the now empty section. 

� You can add a section by clicking New SectionNew SectionNew SectionNew Section, specifying the name, dictionary and, 
specifying the *)default view for the section and then clicking SaveSaveSaveSave. Here, you can 
also define at which place the section should be placed in the list of sections 
(section selector etc.). Type the desired order number in the Sort indexSort indexSort indexSort index field. Note 
that this has to be done starting at 1, and preferably for all sections in the 
dictionary. 

� You can change the name, the sort order and the *)default view of the section after 
clicking the section’s name on the list. 

� You can remove one or more sections by selecting the box(es) beside the section 
name(s) on the list and clicking Delete Selected...Delete Selected...Delete Selected...Delete Selected....  
Note!Note!Note!Note! When you remove a section you also delete all content, i.e. all term records in 
the section!!! 

� If you wish to purge the contents of a section or sections, but keep the section, 
select the box(es) beside the section name(s) on the list and click EmptyEmptyEmptyEmpty Selected...Selected...Selected...Selected.... 

User groups that should be able to read the terms in the section and change, add or remove 
term records (and export and import data) in the section are described under Access Editor and 
Permission Schemes respectively.  
*) Please note: The selected default view for the section will be applied to all user groups, 
including administrators. 

History: Show changes in History: Show changes in History: Show changes in History: Show changes in a a a a dictionary and undo changesdictionary and undo changesdictionary and undo changesdictionary and undo changes    
If you wish to undo an import, you can do for example as follows: 
1) Choose the desired dictionary. 
2) Click on the arrow (in the Restore column) alongside the position to which you want to 

restore the database. 
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3) Confirm that you want to restore the database to the selected position (e.g. 21 February 

9:05). 
Note! Note! Note! Note! The dictionary history only runs back to the latest change of the dictionary structure. 
 

Edit Domains: Add, edit and delete domains and subdomainsEdit Domains: Add, edit and delete domains and subdomainsEdit Domains: Add, edit and delete domains and subdomainsEdit Domains: Add, edit and delete domains and subdomains    
How to specify domains and subdomains. While working you can show or hide subdomains by 
clicking on their name. 
 
Add a domain: 
1. Select the desired dictionary from the Dictionary Dictionary Dictionary Dictionary dropdown. 
2. Right click All domainsAll domainsAll domainsAll domains and choose Add domainAdd domainAdd domainAdd domain. 
3. Write over the text "New domain" shown in the box at the bottom of the domain list with 

the name of your new domain. 
Tips (in Internet Explorer): Press    shift+Ctrlshift+Ctrlshift+Ctrlshift+Ctrl and type in the name. Confirm by pressing Enter. 

4. Repeat steps 2 and 3 for all main domains. 
If you want to have subdomains: 
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5. Right click on a domain and choose Add domainAdd domainAdd domainAdd domain. 

 
6. Write over the text New domain in the box that appears with the name of the subdomain 

and confirm by pressing Enter. 
7. Repeat steps 5 and 6 for all subdomains of a main domain. 
8. Repeat steps 5 and 6 also for other main domains that are to have subdomains. 

When the domain tree is ready, click SaveSaveSaveSave. 
 
To rename a domain: 
1. Right click on the domain name and choose Edit domainEdit domainEdit domainEdit domain. 
2. Write over the domain name that is shown in the box with the new domain name. 
3. Confirm by pressing Enter. 
 
To remove a domain: 
1. Right click on a domain and choose Delete domainDelete domainDelete domainDelete domain. 
2. Confirm with OKOKOKOK (or undo by pressing CancelCancelCancelCancel). 
Note!Note!Note!Note! When you remove a domain, the term records that belonged to that domain will then 
belong to the nearest preceding domain (above). 
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Subclasses: Create subclasses of term recordsSubclasses: Create subclasses of term recordsSubclasses: Create subclasses of term recordsSubclasses: Create subclasses of term records    
Please note that the subclass functionality will not be supported in coming TermWeb versions. 
Terms in a certain subclass can be found in several different sections of a dictionary. 
A subclass for a term record is created among the general fields in the same way as for a 
section (Edit concept level fields). 
Subclasses of term records can be used for two different purposes: 
1) To show term records in the subclass in the same way (with the same view) for all users 
except the administrator.  
2) To limit a specific user group to viewing term records of a certain subclass only.  
 
A) How to create the same view of a subclass for all users except the administrator: 
(You can otherwise apply a user-group specific view under “Groups".)  

1) Create a new view, e.g. without administrative information. See Edit ViewsEdit ViewsEdit ViewsEdit Views. 

 
2) Create a subclass: Click New subclNew subclNew subclNew subclassassassass, type in the name of the new subclass, select the 

dictionary for which the subclass is to be valid and choose the view created in step 1. 
 
B) How to create a subclass that is user-group specific: 

1) Create a filter with the condition that term records belong to a specific subclass 
(Subclass EQUALS...). 

2) Apply this filter to the user group. 
This user group will then only see the term records that belong to this subclass, and with the 
view that has been specified for the subclass. 
 

Edit Views: Add, change, anEdit Views: Add, change, anEdit Views: Add, change, anEdit Views: Add, change, and delete views for a specific dictionary.d delete views for a specific dictionary.d delete views for a specific dictionary.d delete views for a specific dictionary.    
For example: If you want to hide the fields “Created by", “Creation date", “Changed by", and 
“Change date", on the term level for a specific user group, do as follows: 

1) Click Edit ViewsEdit ViewsEdit ViewsEdit Views. 
2) Click Add view...Add view...Add view...Add view.... 
3) Give the view a descriptive name. 
4) Specify which dictionary applies. 
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5) Deselect the fields that are to be hidden from view. 

 
6) Click Create viewCreate viewCreate viewCreate view. 
7) Click Admin ViewAdmin ViewAdmin ViewAdmin View and then GroupsGroupsGroupsGroups. 
8) Click the group’s name. The Group dataGroup dataGroup dataGroup data dialog appears. 
9) For each dictionary, Ctrl-click the view or views to be available to the group in the ViewViewViewView: : : : 

dropdown and then click Update GroupUpdate GroupUpdate GroupUpdate Group. 

 
The users in the group will then not be able to see the deselected fields in the view or edit mode 
(assuming that the group has Write access to a part of the relevant dictionary). 
 
When a member of the group logs in, he or she will be able to choose between the available 
views (if more than one view was selected above): 

 
Note: If a view is used elsewhere in a system, e.g. as a default view for a user group, it cannot 
be deleted from the list. 
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Import: To import term data Import: To import term data Import: To import term data Import: To import term data     
Please note that there normally has to be a dictionary structure into which term data can be 
imported. The alternative is to use the Quick import option (see below). 

Quick importQuick importQuick importQuick import    

If you want to import an earlier exported dictionary data file (or a correctly structured import 
file in Excel or TBX format) and make TermWeb recreate the structure, you can choose the quick 
import option from AdminAdminAdminAdmin > ImportImportImportImport. This saves the job of having to import the dictionary 
structure before importing the term data. Then, just give the dictionary a name in the Dictionary 
name field, browse for and select the dictionary data file and click Create Dictionary and ImportCreate Dictionary and ImportCreate Dictionary and ImportCreate Dictionary and Import. 

 
If you import an Excel or TBX file using the Quick import option, though, a dictionary structure 
can be created automatically. Please note that also domains and subdomains will be created 
automatically, but picklist fields like Part of speech will be created as single-line text fields, but 
can be changed into picklists with existing values by using the Generate picklist from existing Generate picklist from existing Generate picklist from existing Generate picklist from existing 
valuesvaluesvaluesvalues option in the dictionary definition. 
Refer also to the section “Dictionaries: Edit/delete dictionary, export/import dictionary 
definitions” above. 

Data import onData import onData import onData import onlylylyly    

Data in the following formats can be imported to a TermWeb dictionary: 
- TBX TBX TBX TBX (TBX basic fields are available for dictionary setup in TermWeb.) 
- ExcelExcelExcelExcel (xls or xlsx file), where tab names are mapped to existing dictionary sections, and 
column headings (from left to right) are mapped to existing concept-level fields (term record 
fields) and existing languages followed by their term-level fields, with a set of columns per 
language; the language name followed by the corresponding term-level fields. 
Tip:Tip:Tip:Tip: If using Excel for collection and import of additional concept data, e.g. terms in another 
language, first export desired term records with desired fields (including Concept ID) and desired 
languages, e.g. source language and new target language, from the dictionary. Then have the 
empty target language columns filled in. Finally, import only the target language data with 
synchronization on Concept ID. 
- TermWeb 2 XMLTermWeb 2 XMLTermWeb 2 XMLTermWeb 2 XML (for compatibility with earlier installations) 
- MultiTerm iX XMLMultiTerm iX XMLMultiTerm iX XMLMultiTerm iX XML    
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Procedure:Procedure:Procedure:Procedure: 
1) Click Admin and then the ImportImportImportImport icon. 

 
2) If you want to import terminology data using an existing settings file, first select the 

dictionary name in the Selected DictionarySelected DictionarySelected DictionarySelected Dictionary list and then click the settings file name 
under Available settingsAvailable settingsAvailable settingsAvailable settings.  
To change an existing settings file, click EditEditEditEdit on the line of the settings file. 
To create a new settings file click Add new settingsAdd new settingsAdd new settingsAdd new settings, name the settings, choose a 
dictionary from the Import in DictionaryImport in DictionaryImport in DictionaryImport in Dictionary dropdown, define whether the import settings 
are to be visible to yourself (and administrators) only (Private), or to all users with 
import rights (Public) in the VisibilityVisibilityVisibilityVisibility dropdown. Then specify the new settings for 
import synchronization, i.e. how the import file will be synchronized with existing 
information in the section(s), what will be imported, etc.  
Click SaveSaveSaveSave, and then click the settings file name. 

3) Click Browse,Browse,Browse,Browse, scroll to and choose the file you want imported. 
4) Click Next >Next >Next >Next >.  
5) Click Next > Next > Next > Next > if the validation report is OK. 
6) Unless already decided, select to what dictionary section the terminology data should be 

imported by mapping the dictionary section(s) to the section name(s) in the import file 
and then click NextNextNextNext. 

7) If there are fields on the term record (concept) level in the import file that were not 
already connected (mapped) with the fields in the dictionary, select the fields that 
should be mapped and then click MapMapMapMap for one field name pair at a time in the Map Map Map Map 
concept fields concept fields concept fields concept fields text box. 
When you are finished, click Next >Next >Next >Next >.  

8) Repeat step 7 if necessary on the term level (Map termMap termMap termMap term    fieldsfieldsfieldsfields) and then click Next >Next >Next >Next >. 
9) Repeat step 7 if necessary for languages (Map languagesMap languagesMap languagesMap languages) and then click Next >Next >Next >Next >. 
10) You may now get a question if languages, sections, domains or fields existing in the 

import file, but missing in the receiving dictionary should be created in the dictionary: 
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Select the desired data categories to be created and click Next >Next >Next >Next >. 

11) If you are satisfied with the mapping, click Next >Next >Next >Next > in the Import settings complete Import settings complete Import settings complete Import settings complete text 
box. Otherwise, you can click ChangeChangeChangeChange by the mapping you want to change. 

12) Click Finish Finish Finish Finish in the Import complete Import complete Import complete Import complete box. 
Note! The next time you want to import a similar file, the settings for mapping the 
import file and dictionary are remembered and will be available. 

 
Note! Note! Note! Note! When importing data from a file in the TermWeb 2 XML format: 
� If you want the same Concept ID in TermWeb 2 to apply in TermWeb 3: Tick "Synchronize on 

concept ID".  
� If you want to create a new Concept ID for term records: Tick “Add import concept as new" 

(recommended). 
For any supplementary import of previously exported and supplemented TermWeb 2 data, 
tick "Synchronize on index term". 
Note! Note! Note! Note! Any domain information in the import file will be transferred to the database only if 
the domain or subdomains already exist in the database. 

Example:Example:Example:Example:    
You have received an (earlier exported) Excel file including the concept ID and new terms in 
French and Dutch and want to import data to the existing database where there are already 
terms in other languages. Use the import settings indicated in the figure below.  
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Use "Merge parts", however, if you want to supplement with new terms andandandand possibly new 
detailed information about existing terms. 

Import settingsImport settingsImport settingsImport settings    

An import setting defines how a file should be imported. You can define which fields and 
languages that should be affected, and also specify how concept and terms should be 
synchronized. 

Select a settingSelect a settingSelect a settingSelect a setting    

Your available settings are displayed in the import settings selection view when you click on the 
ImportImportImportImport button in the Admin view. You will see both your own settings as well as settings 
defined by other users and declared to be public. If you are an administrator all import settings 
for all users are displayed (both private and public). Click on an import setting to select it and 
then click the ImportImportImportImport button to start the import wizard. 
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Create or edit a settingCreate or edit a settingCreate or edit a settingCreate or edit a setting    

To add a new setting, click the NewNewNewNew button in the import settings selection view. To edit a 
setting, click the EditEditEditEdit button for the setting you want to edit. You will see the settings editor 
where you define your import setting. 

Start by entering a name for the settings. The name must be unique among all your defined 
import settings. 

Select the dictionary in which the file should be imported. You can only select from the 
dictionaries where you have import permissions. 

Select the visibility for the settings. Private means that only you and administrator users will be 
able to use the setting. Selecting Public lets all users with import permission in the dictionary 
use the settings. 

SynchronizationSynchronizationSynchronizationSynchronization    

With the synchronization features you can combine existing term data with imported data, e.g. 
adding translations for existing terms. You specify how concepts should be recognized for 
synchronization, and what action should be performed in that case. The preferred way of 
synchronizing concepts is to use the Concept ID, but TermWeb also lets you synchronize on 
index term. Since TermWeb 3.5 you also have the possibility to synchronize on Term ID on the 
term level. 

Concept synchronization methodsConcept synchronization methodsConcept synchronization methodsConcept synchronization methods    

The following methods are available for concept synchronization: 

• Add Add Add Add import import import import concept as newconcept as newconcept as newconcept as new - No synchronization is performed, the imported concept is always added as a 
new concept and given a new concept ID. 

• Synchronize on concept IDSynchronize on concept IDSynchronize on concept IDSynchronize on concept ID - The imported concept is matched against any existing concept with same ID 
in the database. If no such concept exists, the imported concept is added as a new concept, and its 
concept ID is kept as is. 

• Synchronize on index termSynchronize on index termSynchronize on index termSynchronize on index term - The imported concept is matched against any existing concept with at least 
one term with same name in any of the selected languages. If no such concept exists, the imported 
concept is added as a new concept and given a new concept ID. You need to select at least one language 
for synchronization with this option. 

Selected languages for index term synchronization does not affect which terms are imported, only which terms 
should be checked for concept synchronization.    
    
Synchronization ActionSynchronization ActionSynchronization ActionSynchronization Action    

The Synchronization Action defines what should be done with synchronized concepts. You can 
select one of the following actions: 

• Do not importDo not importDo not importDo not import - No changes are done to the existing concept and no new concept is added. 

• Replace old conceptReplace old conceptReplace old conceptReplace old concept - The existing concept is deleted and the imported concept is saved. 

• Overwrite partsOverwrite partsOverwrite partsOverwrite parts - Selected parts from the imported concept is used to overwrite parts of the existing 
concept. See more details below. 

• Merge partsMerge partsMerge partsMerge parts - Selected parts from the imported concept is merged into the existing concept. See more 
details below. 

• Fill in partsFill in partsFill in partsFill in parts - Selected parts from the imported concept is filled in into the existing concept. See more 
details below. 
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Selecting partsSelecting partsSelecting partsSelecting parts    

You select the parts of the imported conceptimported conceptimported conceptimported concept that you wish to use for updating the existing 
concept in the database. You can select any field on the concept level, and/or terms in selected 
languages. Selected parts from the import concept are then used to update the synchronized 
concept, according to selected action. 

The terms in the synchronized concepts can also be synchronized. You can select how TermWeb 
should attempt to synchronize the terms in the Term synchronization settings. 

When two terms are synchronized, every field value of the term entries is handled depending on 
selected action: 

• Overwrite partsOverwrite partsOverwrite partsOverwrite parts - The imported field value always overwrites the existing value, or deletes it if the 
imported value was empty. 

• Merge partsMerge partsMerge partsMerge parts - The imported field value overwrites the existing value, but the existing value is kept if the 
imported value was empty. 

• Fill in partsFill in partsFill in partsFill in parts - The imported field value is only added if there was no existing value for the field. 

Same rules also applies for concept-level fields. 

For imported terms that are not are synchronized, the following actions take place: 

• Overwrite partsOverwrite partsOverwrite partsOverwrite parts - All existing non-synchronized terms in the imported term language are deleted, and 
replaced by the imported terms. 

• Merge partsMerge partsMerge partsMerge parts - The imported term is added to the existing concept. 

• Fill in partsFill in partsFill in partsFill in parts - The imported term is only added if there was no existing term in the imported term's 
language. 

Term synchronization settingsTerm synchronization settingsTerm synchronization settingsTerm synchronization settings    

You can select how terms should be synchronized within synchronized concepts. The options are 
as follows: 

• Synchronize on term IDSynchronize on term IDSynchronize on term IDSynchronize on term ID - The imported term is synchronized with any existing term with same term ID. 
This option is only available if Synchronize on concept ID is selected. 

• Synchronize on similaritySynchronize on similaritySynchronize on similaritySynchronize on similarity - The imported term is compared to the existing terms, and if there is enough 
similarity between the entries, they are synchronized. The fields being compared are term name, language, 
region and orthographical variant, and the probability for synchronization match depends on the 
combination of matching values in these fields. Two entries with same term name and language are 
always synchronized. 

• No synchronizationNo synchronizationNo synchronizationNo synchronization - No term synchronization is performed 

Terms can only be synchronized within synchronized concepts, e.g. entries with matching term 
IDs will not be synchronized if their concepts not are synchronized. 

When you are done defining your import settings, click the SaveSaveSaveSave button to save them, or CancelCancelCancelCancel 
to leave the editor without saving your changes. 

    
Note!Note!Note!Note! If you want to “undo" a data import and restore the database to the position prior to the 
import, select Admin > HistoryAdmin > HistoryAdmin > HistoryAdmin > History. It is not possible to “undo" a complete data import by using the 
history function for a term record. 
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NoteNoteNoteNote!!!! The metadata fields cannot be changed by editing the file to be imported. The "Created 
by", "Creation date", and "Change date" fields are set to the importer's ID and time of the 
import.  

Importing using Permission SchemesImporting using Permission SchemesImporting using Permission SchemesImporting using Permission Schemes    

When term data is imported with Permission Schemes enabled the same permissions are 
enforced as for manual editing. 

This means, that besides allowing the Import permission in the scheme, some other permissions 
should also be granted depending on what the users should be able to do during the import 
operation. 

The table below describes what permissions are needed for different import and synchronization 
cases: 

Import typeImport typeImport typeImport type    
Synchronization Synchronization Synchronization Synchronization 

typetypetypetype    
Permissions needed (for type of Permissions needed (for type of Permissions needed (for type of Permissions needed (for type of 

change)change)change)change)    

Import as new N/A 
Create ConceptCreate ConceptCreate ConceptCreate Concept (for importing new 
concepts) 

Import with concept synchronization 
(on concept ID or index term) 

Replace old 
concept 

Create ConceptCreate ConceptCreate ConceptCreate Concept and Delete ConceptDelete ConceptDelete ConceptDelete Concept 
(all changes) 

Overwrite parts 

Edit ConceptEdit ConceptEdit ConceptEdit Concept (all changes) 
Edit Concept Level FieldsEdit Concept Level FieldsEdit Concept Level FieldsEdit Concept Level Fields (for changes 
to concept level fields) 
CreateCreateCreateCreate    TermTermTermTerm and Delete TermDelete TermDelete TermDelete Term (for all 
changes to non-synchronized terms) 
Edit TermEdit TermEdit TermEdit Term (for changes to synchronized 
terms) 

Merge parts 

Edit ConceptEdit ConceptEdit ConceptEdit Concept (all changes) 
Edit Concept Level FieldsEdit Concept Level FieldsEdit Concept Level FieldsEdit Concept Level Fields (for changes 
to concept level fields) 
Create TermCreate TermCreate TermCreate Term (for all changes to non-
synchronized terms) 
Edit TermEdit TermEdit TermEdit Term (for changes to synchronized 
terms) 

Fill in parts 

Edit ConceptEdit ConceptEdit ConceptEdit Concept (all changes) 
Edit Concept Level FieldsEdit Concept Level FieldsEdit Concept Level FieldsEdit Concept Level Fields (for changes 
to concept level fields) 
Create TermCreate TermCreate TermCreate Term (for all changes to non-
synchronized terms) 
Edit TermEdit TermEdit TermEdit Term (for changes to synchronized 
terms) 
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Importing domain information from ExcelImporting domain information from ExcelImporting domain information from ExcelImporting domain information from Excel    

In Excel, add a concept-level column with the heading "Domain". Enter domain (or domain and 
subdomain) information in the following format for all conceptsconceptsconceptsconcepts needing a domain 
classification. 
 
Three examples: 
1) SCIENCES 
 
2) SCIENCES > geography 
 
3) BUSINESS & ADMINIST > public administration;SCIENCES > geography 
 
In the latter case dual subdomain classification is imported. 
Please note: From version 3.9 a check is performed whether the domain names in the import file 
exist in the dictionary. If a domain does not exist, a message "Unknown Domain Values" is 
displayed and you are given the possibility to go back and adapt the import file OR the 
dictionary domains before a reattempted import. 
 

Export: To eExport: To eExport: To eExport: To export term data xport term data xport term data xport term data     
To export term data, e.g. for review or supplementary information, you can do the following:  
If you do not want to export an entire dictionary, create a filter under Search viewSearch viewSearch viewSearch view > FiltersFiltersFiltersFilters.  
1. Click ExportExportExportExport. 
2. If desired, filter the export settings by dictionary: 

Select a completed settings file from Available settingsAvailable settingsAvailable settingsAvailable settings list. 
To change an existing settings file, click EditEditEditEdit on the line of the settings file. 
If there are no appropriate export settings files for the dictionary, create a new one (click 
Add new settingsAdd new settingsAdd new settingsAdd new settings). Write the name of the export settings file, for which dictionary it is 
applicable, whether the export settings are to be visible for you only, and administrators, 
(Private) or for other users with export rights (Public) and the desired format of the export 
file. 

You can choose one of the following formats: 
- TBX (TermBase eXchange); standard format according to ISO/DIS 30042 
- TermWeb 2 XML; compatible with previous versions of TermWeb (This option is only available 
in earlier TermWeb versions than 3.18, e.g. version 3.9.)  
- MultiTerm iX XML 
- Excel. Here, section names normally become tab names. From version 3.16 you can select to 
place all exported concepts in one sheet (where the dictionary name will be present as the tab 
name) and also to include the Dictionary name in one column.  
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Concept-level field names, followed by language name and language-level field names become 
column names. 
If you want to give a custom name to the export file (not only the Dictionary name followed by 
a numeric value), enter that name in the Export file nameExport file nameExport file nameExport file name field: 

 
If you wish to include permalinks in the export file, tick the Export permalinksExport permalinksExport permalinksExport permalinks tickbox. 
Then, the term permalinks will be exported to Excel in a column with the heading [permalink] [permalink] [permalink] [permalink] or 
to TBX in a line like the following:        
<xref id="c1-1-pml" type="permalink" target="http://demo310.termweb.se/termweb/view/iseb/ised"/>,  

where c1c1c1c1 is the termEntry id (TermWeb Concept ID =1), and c1c1c1c1----1111 is the tig id, and 
http://demo310.termweb.se/termweb/view/iseb/ised is the permalink to the term. 
 
If you want to export also possible attachments of concepts (thumbnail pictures), click the 
Export attachmentsExport attachmentsExport attachmentsExport attachments tickbox:::: 

 
 
Then choose the filter in the Select concepts by filter Select concepts by filter Select concepts by filter Select concepts by filter field. 
 
Indicate which languages and fields you want in the export file.  
Click SaveSaveSaveSave when you have finished with the export settings. 
3. Select the export settings file and click ExportExportExportExport. 
4. A picture is now shown with the mapping between the language names from the dictionary 

and export files. If you want to, you can rename the export file language names. Otherwise, 
click Next >Next >Next >Next >. 

5. A picture with the mapping between the concept level fields is shown as described above. 
Change as needed (does not apply to pre-defined TBX field names) and then click NexNexNexNext >t >t >t >. 
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6. A picture with the mapping between the field names at the term level is shown. 
Change as needed and then click Next >Next >Next >Next >.  
The Export complete!Export complete!Export complete!Export complete! box is shown with information about the number of exported term 
records. 

7. Click Open in browserOpen in browserOpen in browserOpen in browser if you want to review the file. Click Save fileSave fileSave fileSave file and save the file at an 
appropriate location and with an appropriate name. 

8. Click FinishFinishFinishFinish when you are finished. 
 
Note! You can use the same export settings, with minor modifications if necessary, the next 
time you want to create a similar export file. 
Note! If you want to validate an exported TBX file, the dtd file (*.dtd) must be in the same folder 
as the TBX file. 
Note!Note!Note!Note! Concept relations are not included in the export file. From version 3.12, attached objects 
as well as permalinks can be included in the export file. Links to external objects are included 
but not (apart from web addresses) reimportable and thereafter directly usable. For export of an 
entire dictionary, internal links (cross-references between concepts) are included and will be 
recreated during import to another installation, but e.g. file repository data has to be packed 
(ZIPped) and copied separately to the new installation. (See information on File repository in the 
"Add cross-references, pictures and other objects to term records" section.) 
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Note:Note:Note:Note: For Excel exports, you can choose to sort the exported terms according to a picklist field 
value, e.g. Usage status: Select the desired term-level field under Order terms by fieldOrder terms by fieldOrder terms by fieldOrder terms by field and the 
resulting exported Excel file will contain the term with the first picklist value first, and to the 
right of these columns, the term with next picklist value. As an example, this is useful for export 
of structured term databases with pairs of preferred and non-recommended terms. There, all 
preferred terms (or single unclassified terms) will be in the leftmost columns for each language. 
Please note that unclassified terms (terms with no picklist value) will be put in columns after 
terms with a picklist value. Also note that the order between the picklist values is defined in the 
dictionary definition. 
Sample export (acc. to standard order between picklist values of TBX Basic field Usage status): 
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Groups: Add, modify or delete groupsGroups: Add, modify or delete groupsGroups: Add, modify or delete groupsGroups: Add, modify or delete groups    
(See also the section on using language groups.) 
If necessary, you can add a new user group. 
You can also use a standard filter (for a certain dictionary) and a view (for a certain dictionary) 
for the group, but they should be specified first, see the sections “Use filters to search and 
export" and “Edit Views: Add, change and delete views for a specific dictionary."  
You can also change the name, description, filter and view for the group, or remove the group.  
Group members are specified under Group MembersGroup MembersGroup MembersGroup Members.  
Which members are to receive access to which sections of dictionaries is set under Access EditorAccess EditorAccess EditorAccess Editor    
(or by using Permission SchemesPermission SchemesPermission SchemesPermission Schemes, defining a set of rights for the user groups and then assigning 
this permission scheme to the desired dictionary or section). 

Add a groupAdd a groupAdd a groupAdd a group    

1. Click GroupsGroupsGroupsGroups. 
2. Click NewNewNewNew    GroupGroupGroupGroup. 
3. Indicate the namenamenamename of the user group, descriptiondescriptiondescriptiondescription, the desired automatic logout after 

inactivity period Session timeoutSession timeoutSession timeoutSession timeout (if differing from the default, which is normally 60 
minutes), and any viewviewviewview or filterfilterfilterfilter that is to be applicable for the group. Filter and view can be 
set individually for each dictionary.  
For TermWeb installations with the API add-on product installed, you can choose if you 
want the users within the group to be able to access TermWeb via the API by using the 
Allow API accessAllow API accessAllow API accessAllow API access checkbox.  
If you want the group members to change their passwords at regular intervals, i.e. you want 
to set a maximum password age, you can also specify a Change passwordChange passwordChange passwordChange password interval here: 

 
If a user is a member of several groups, the lowest value among the groups is applied for the 
user. 
(Views are defined under Edit ViewsEdit ViewsEdit ViewsEdit Views and filters under Search ViewSearch ViewSearch ViewSearch View > FiltersFiltersFiltersFilters.) 

4. Click Create GroupCreate GroupCreate GroupCreate Group. 

Change information about a groupChange information about a groupChange information about a groupChange information about a group    

1. Click GroupsGroupsGroupsGroups. 
2. Click the user group’s name. 
3. Change the name, description, session timeout, and, if desired, password renewal interval 

and any filter and view (or views) (per dictionary) that are applicable to the group. 
An example:  
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Here, no initial filter, but the view "Minimal view TT" is selected for the current group and 
the "TechniTerm and more" dictionary. To deselect a filter, select "No filter - All concepts 
visible" To deselect one or more views, Ctrl-click the currently selected view or views.  
If you want more than one view to be selectable by the users in the group, select these 
views by Ctrl-clicking.  

4. Click Update GroupUpdate GroupUpdate GroupUpdate Group. 

Remove a groupRemove a groupRemove a groupRemove a group    

1. Click GroupsGroupsGroupsGroups. 
2. Tick the box to the left of the user group name. 
3. Click Delete Selected..Delete Selected..Delete Selected..Delete Selected... 
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Exporting and importing user and group informationExporting and importing user and group informationExporting and importing user and group informationExporting and importing user and group information    

If you want to create a similar environment, e.g. a backup environment, to your existing client, 
it is possible not only to export and import dictionary structure (dictionary definition) and 
dictionary contents, but also all defined users and user groups. You can do thie either from the 
Admin > GroupsAdmin > GroupsAdmin > GroupsAdmin > Groups or Admin > UsersAdmin > UsersAdmin > UsersAdmin > Users dialog. 

 
Click Export and save the file. 
When you want to import the user setup to the new environment; 
1. Click BrowseBrowseBrowseBrowse and select the exported TermWeb_users_groups.xml file. 
2. Click Import FileImport FileImport FileImport File. The following dialog will be displayed: 

 
Here, you can select to create a new user/new group, if a user/group with the same name 
already exists in the new client or just overwriting existing users/groups with the ones in the 
imported xml file. 
Please note that you will have to review and set group membership, permission schemes, etc. 
after users, groups (and dictionaries) have been imported to the new environment.  
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Guest Account: Activate/deactivate and change information about guest usersGuest Account: Activate/deactivate and change information about guest usersGuest Account: Activate/deactivate and change information about guest usersGuest Account: Activate/deactivate and change information about guest users    
Note: This function requires guest functionality to be enabled in the installation. 
1. Click Guest AccountGuest AccountGuest AccountGuest Account. 
2. Activate a guest account by ticking the box Enable guest accountEnable guest accountEnable guest accountEnable guest account. 
3. a) If the guest user is to log in the usual way: Fill in the user name and password and select 

NormalNormalNormalNormal. 
b) If the guest user is to log in automatically when they visit the web site: Select AutomaticAutomaticAutomaticAutomatic    
(Always) (Always) (Always) (Always) or AutomaticAutomaticAutomaticAutomatic    (when client is specified in URL)(when client is specified in URL)(when client is specified in URL)(when client is specified in URL). 

4. Click SaveSaveSaveSave. 
Everyone who visits the web site will now be able either to log in 
a) with the specified user name and password or  
b) automatically (to only one predefined client of many) or 
c) automatically to a client when that client name is specified in the TermWeb URL (e.g. 
http://demo38.termweb.se/demo38/client/klient, where "klient" is the client login name). 
Note! Note! Note! Note! Several users can use the guest account at the same time, if this function is enabled. 
What guest users can see is set under Access EditorAccess EditorAccess EditorAccess Editor or Permission Schemes Permission Schemes Permission Schemes Permission Schemes and with filter and 
views per dictionary for the user group GuestsGuestsGuestsGuests.  
Guest users cannot change term data; they can only search for terms, use pre-defined filters 
and create temporary filters. If you want, you can easily deactivate the guest account by 
clicking Guest AccountGuest AccountGuest AccountGuest Account, deselecting Enable guest accountEnable guest accountEnable guest accountEnable guest account and clicking SaveSaveSaveSave. 
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Users: Add, edit, deactivate/activate or delete a userUsers: Add, edit, deactivate/activate or delete a userUsers: Add, edit, deactivate/activate or delete a userUsers: Add, edit, deactivate/activate or delete a user    

Add a userAdd a userAdd a userAdd a user    

1. Click UsersUsersUsersUsers. 
2. Click New UserNew UserNew UserNew User. 
3. Type in a user name, full name, e-mail address, and primary group membership (and indicate 

if the user is to be an administrator or system administrator). 
Note! If you have not defined any group membership this can also be done under GroupGroupGroupGroup    
MemMemMemMembersbersbersbers. 
If you want to set the password for the new user, deselect the Send password reset link in Send password reset link in Send password reset link in Send password reset link in 
email email email email checkbox and fill in the desired password twice.  
If you want to create a temporary user only, fill in or select the expiration dateexpiration dateexpiration dateexpiration date for the 
account. If the user tries to log in later, a "This user account is currently disabled" message will be 
issued. For further options, see below under "Change information about a user". 

In the above case, the user will get not get an email with the credentials (this will have to 
be communicated via another channel) but is required to change the password after logging 
in.  
(If only the ActiveActiveActiveActive checkbox is selected, no email is sent and there is no requirement to 
change password.) 

If you fill in the form as above, the user will get an email and is required to select a new 
password him- or herself before logging in. 
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4. Click Create UserCreate UserCreate UserCreate User (and then Admin View Admin View Admin View Admin View if you want to return to the administrative function 

icons or Search ViewSearch ViewSearch ViewSearch View if you want to return to the search position). 
 
For the Clients (Add ClientAdd ClientAdd ClientAdd Client) and User Roles (Add RoleAdd RoleAdd RoleAdd Role) functions, please see below. 
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Change information about a userChange information about a userChange information about a userChange information about a user    

1. Click UsersUsersUsersUsers. 
2. Click the user’s name. A dialog box similar to the one below will appear: 

 
3. Make changes in the user data.  

If you want to set an automatic expiration date for the user account, enter the date in ISO 
format (or select it from the calendar). At the selected date, the user will be inactivated. 
Deselect the ActiveActiveActiveActive checkbox if you want to temporarily deactivate the user. 
Click AddAddAddAdd    rrrroleoleoleole to add a role to the user in the User RolesUser RolesUser RolesUser Roles dropdown. As an example, select 
User editor for the user to be able to edit other users' info and place these other users in 
groups. 
Here, a "normal" user can also be given the Administrator role for a certain dictionary: 

 
This means the user is given the rights to 
a) edit the dictionary's definition 
b) add, edit and delete sections of the dictionary 
c) add, edit and delete views for the dictionary 
d) work with the history of the dictionary (including restore to an earlier state) 
e) import to and export from the dictionary. 

4. Click Update UserUpdate UserUpdate UserUpdate User. 
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If the multiple-client user function is enabled in your installation, and you are logged in as a 
system administrator, you can also select more clients that the user should be able to access: 

 
Click Add ClientAdd ClientAdd ClientAdd Client and select the client(s) that the user should be able to access using same login. 
Then be sure to place the user in the desired group(s) in the additional clients. 
 

Remove a userRemove a userRemove a userRemove a user    

1. Click UsersUsersUsersUsers. 
2. Tick the box to the left of the user's name. 
3. Click Delete Selected..Delete Selected..Delete Selected..Delete Selected... 
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Group Members: Indicate which user is a member of a particular group and to Group Members: Indicate which user is a member of a particular group and to Group Members: Indicate which user is a member of a particular group and to Group Members: Indicate which user is a member of a particular group and to 
which groups a particular user belongswhich groups a particular user belongswhich groups a particular user belongswhich groups a particular user belongs    
Place users in one or more groups. 

 
Columns can be sorted (ascending or descending) on the basis of the group name, number of 
users, or user names by clicking on the relevant column heading. 
You can either click a group name to find out which users are members of the group or click on 
a user name to find out and change the groups to which a user belongs. You move users and 
groups by selecting the name, using the blue arrows to move them, and then confirming by 
clicking ApplyApplyApplyApply. 
When you have completed the task click Admin ViewAdmin ViewAdmin ViewAdmin View or Search ViewSearch ViewSearch ViewSearch View. 

Access Editor: Set the user group access to dictionarAccess Editor: Set the user group access to dictionarAccess Editor: Set the user group access to dictionarAccess Editor: Set the user group access to dictionaries and sectionsies and sectionsies and sectionsies and sections    
Note!Note!Note!Note! See also the alternative method Permission SchemesPermission SchemesPermission SchemesPermission Schemes below. 
You can specify the following for every combination of dictionary, section and user group:  
- which groups can read (or not) the terms in the section (Read AccessRead AccessRead AccessRead Access or No accessNo accessNo accessNo access). 
- which groups can add and edit terms in the section (Read/Write accessRead/Write accessRead/Write accessRead/Write access) 
- which groups can export, import, or both export and import data in the section 
Note that the status for a specific term record can also determine who is able to view and work 
with a term record. 
Note!Note!Note!Note! Authority for the Default group to All dictionaries/All sections should normally be set to 
No accessNo accessNo accessNo access after an administrator group with at least the member Admin is created. 
You can then give different authorities to the groups you create in the system. 

Example of procedures for authority settingsExample of procedures for authority settingsExample of procedures for authority settingsExample of procedures for authority settings    

This part of the manual is for a newly installed program (but there must be sections).  
When setting authority settings at a later point in time, points 1-3 can be skipped. 
1. Create a group for administrator(s). 

Click GroupsGroupsGroupsGroups > New GroupNew GroupNew GroupNew Group and then specify the name and description of the group. 
2. Specify who will be included in the administrator group. Directly after installation, it is the 

pre-defined user admin.  
Click Group MembersGroup MembersGroup MembersGroup Members and then the admin group’s name. Select Admin and move admin to 
the Users in groupUsers in groupUsers in groupUsers in group box with the blue arrow. Click ApplyApplyApplyApply and then Admin ViewAdmin ViewAdmin ViewAdmin View. 

3. Remove general authority for everyone. 
Click Access EditorAccess EditorAccess EditorAccess Editor and choose  
Read/Write AccessRead/Write AccessRead/Write AccessRead/Write Access for the admin group 
and 
No access No access No access No access for the Default group. 

4. Create the user groups that are needed (groups of people that will have special authority to 
at least one section).  
Click GroupsGroupsGroupsGroups > New GroupNew GroupNew GroupNew Group and specify for one group at a time name, description and which 
views and filters will apply to the TermWeb dictionaries. 
Click Create GroupCreate GroupCreate GroupCreate Group and Admin ViewAdmin ViewAdmin ViewAdmin View when you are finished. 
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5. Create the users that will be in the system. 
Click UsersUsersUsersUsers > New UserNew UserNew UserNew User and specify user name, full name, and password. You can also 
choose which Initial group the user will be a member. (Note! A user can belong to several 
groups.) Finish by clicking Create UserCreate UserCreate UserCreate User for each user.  
Click Admin ViewAdmin ViewAdmin ViewAdmin View when you are finished. 

6. Place the users in groups under Group Members Group Members Group Members Group Members as needed. 
7. Specify authority for each group under Access Editor.Access Editor.Access Editor.Access Editor. 

When All Dictionaries and All Sections are chosen:  
Specify No accessNo accessNo accessNo access for all groups except the administrator's group. 
Then specify authority per dictionary and section.  

Note!Note!Note!Note! If you import a new section of a dictionary, the authority for the dictionary applies 
automatically to the section. If you want to change the authority of a new section, for example 
hide it for some groups, choose the dictionary and the section and then specify No accessNo accessNo accessNo access or 
Read accessRead accessRead accessRead access for the groups in question. 
 

Permission Schemes: Setting detailed access permissions for user groups and Permission Schemes: Setting detailed access permissions for user groups and Permission Schemes: Setting detailed access permissions for user groups and Permission Schemes: Setting detailed access permissions for user groups and 
assigning these permissions to dictionaries and sectionsassigning these permissions to dictionaries and sectionsassigning these permissions to dictionaries and sectionsassigning these permissions to dictionaries and sections    
If you need to decide, for all or parts of the database, more than the no access, read access, 
write access and export/import rights provided by Access Editor, click Permission SchemesPermission SchemesPermission SchemesPermission Schemes and 
Enable Permission SchemesEnable Permission SchemesEnable Permission SchemesEnable Permission Schemes.  
Note!Note!Note!Note! 
This will deactivate the settings made in Access Editor, and activate any Permission Schemes 
settings. Please also note that certain rights may be given to individual users in the AdminAdminAdminAdmin > 
UsersUsersUsersUsers dialog. 
A permission scheme consists of a set of permissions granted for the different user groups. The 
scheme is first edited and saved and then assigned to selected dictionaries and/or sections. 
After having created the user groups (and possibly the users of these user groups), first edit the 
default permission scheme, for all default access rights (normally disabling any automatic 
access for the All users group). Then add a permission scheme for any dictionary or section 
needing specific permissions. The following illustration shows an example of a special 
permission scheme to be applied to a "Suggestions" section. 
Proceed as follows: 
 
1. Click Add Permission SchemeAdd Permission SchemeAdd Permission SchemeAdd Permission Scheme and specify the name and description of the scheme. 
2. For all access permissions on the concept and term level as well as regarding export and 

import, under each permission, add the groups to get the permission.  
Note!Note!Note!Note! If you do not specify any group for a certain permission, only administrators will have 
that permission. 
 

Please note:Please note:Please note:Please note: For later versions of TermWeb, also permissions to print concepts and to restore 
concepts are given to groups in this dialog. 
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3. Click SaveSaveSaveSave. 
4. Click Edit Scheme AssignmentsEdit Scheme AssignmentsEdit Scheme AssignmentsEdit Scheme Assignments. 
 

 
 

5. Select the dictionary (or section) for which the permission scheme shall be applied in the 
left dropdown. 

6. Select the desired permission scheme in the right dropdown. 
If the permission scheme is to be assigned to more than one dictionary or section, click AddAddAddAdd 
and repeat steps 5-6 for that dictionary or section 

7. Click SaveSaveSaveSave. 
 

Default permission sDefault permission sDefault permission sDefault permission schemechemechemecheme    

There is always a default permission scheme available. The default scheme can be edited but not 
removed. In the initial setup the default permission scheme is defined to allow all permissions to 
"All Users" group. It is assigned to "All dictionaries", which gives every user full permissions to 
all terminology data. Edit the default permission scheme to limit the base permissions if 
necessary. 

Create and eCreate and eCreate and eCreate and editditditdit    permission schemespermission schemespermission schemespermission schemes    

To add a new permission scheme, click Add Permission SchemeAdd Permission SchemeAdd Permission SchemeAdd Permission Scheme on the Permission Schemes list 
page. To edit an existing scheme click EditEditEditEdit for the desired scheme. You can also copy an entire 
scheme by clicking CopyCopyCopyCopy. All these actions will open the Permission Scheme Details page. 

Every scheme requires a unique name for identification. You can also optionally enter a 
description of the scheme. 

You then define which groups should be granted permissions. For each listed permission you can 
add one or more group that should be granted the permission. Click Add GAdd GAdd GAdd Grouprouprouproup to get a 
dropdown of the available user groups, and select the desired group. To remove a group from a 
permission, click on the delete icon ( ) to the right of the group. 
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Any user will be granted a specific permission if she is a member of any group with that 
permission granted. 

PermissionPermissionPermissionPermission    dependenciesdependenciesdependenciesdependencies    

Some permissions have dependencies on other permissions. For example, a user cannot edit a 
concept which she cannot view, even if the Edit Concept permission is granted. The available 
permissions with dependencies are described in the table below. 

PermissionPermissionPermissionPermission    DescriptionDescriptionDescriptionDescription    Depends onDepends onDepends onDepends on    

View Concept User can view concepts  

Create Concept User can create new concepts 
View Concept, Create Term (for at least one section 
in the current dictionary) 

Edit Concept User can edit the current concept 
View Concept (and at least one of Edit Concept 
Level Fields, Create Term, Edit Term or Delete Term 
to be able to make any changes) 

Delete Concept User can delete the current concept View Concept 

Edit Concept 
Level Fields 

User can edit fields on the concept level in a 
concept 

Create Concept or Edit Concept 

Create Term User can create a new term in a concept Create Concept or Edit Concept 

Edit Term User can edit an existing term in a concept Edit Concept 

Delete Term User can delete an existing term in a concept Edit Concept 

View Concept 
History 

User can view the history for a concept. 
Restoring from history is allowed if user has 
permission Edit Concept. 

View Concept 

Import 
Concepts 

User can import concepts from file See Importing using Permission Schemes 

Export 
Concepts 

User can export concepts to file View Concept 

When importing you may need additional permissions granted depending on your import 
settings. See Importing using Permission Schemes for more information. 

Assign Assign Assign Assign ppppermission ermission ermission ermission sssschemeschemeschemeschemes    

When you have defined your permission scheme you can assign it to dictionaries and sections. 
Click Edit Scheme AssigEdit Scheme AssigEdit Scheme AssigEdit Scheme Assignmentsnmentsnmentsnments on the Permission Schemes list page to open the Scheme 
Assignments page. 

Click AddAddAddAdd to create a new assignment. You will get a row with two dropdowns; one for 
dictionaries and sections, and one for the permission schemes. Select a combination of 
dictionary/section and scheme to create an assignment. You can delete an existing assignment 
by clicking the delete icon ( ) to the right of the scheme dropdown. 

If no scheme is assigned for a specific section in a dictionary, the scheme assigned to "All 
sections" for the dictionary will be applied. If no scheme is assigned for "All sections", then the 
default permission scheme will be applied.  
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Lock Languages: Lock Languages: Lock Languages: Lock Languages:  Disable certain user groups from adding and editing terms Disable certain user groups from adding and editing terms Disable certain user groups from adding and editing terms Disable certain user groups from adding and editing terms 
in certain languagesin certain languagesin certain languagesin certain languages    
1. First, lock all languages for the "All users" group, as every user is a member of that group. 
2. Select the dictionary where e.g. write access to certain languages should be disabled. 
3. For each relevant user group, click the languages that the members of the user group should 

not be able to add or edit. 
(If you change your mind, Ctrl-click the language.) 

4. Click Apply CApply CApply CApply Changeshangeshangeshanges. 
Please note that the basic access rights to the dictionaries (and their sections) are defined in 
Permission Schemes or Access Editor. 
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Scheduled Jobs: Scheduled Jobs: Scheduled Jobs: Scheduled Jobs:  Regular automated exports of term dataRegular automated exports of term dataRegular automated exports of term dataRegular automated exports of term data    
Here, you can automate the export of terminology data.  
(Please note that also scheduled actions resulting from workflows are listed here.) 
Proceed as follows to schedule exports: 
Click AdminAdminAdminAdmin > Scheduled JobsScheduled JobsScheduled JobsScheduled Jobs. A list of currently defined jobs will be displayed. 

 
Here, you can select to order a job to be run immediately (Run nowRun nowRun nowRun now), as an example to make a 

test export, refresh the list (click the circular arrow on green background, ), and view the 
results of a certain export (click [more][more][more][more] and the file link that is displayed). You can also delete 
selected exported files with their corresponding log entries and from the job result log. 
To add a job: 
1. Click Add jobAdd jobAdd jobAdd job. 
2. Give the job a descriptive name, select an export setting (if necessary, define an export 

setting under Admin ViewAdmin ViewAdmin ViewAdmin View > ExportExportExportExport > NewNewNewNew), and enter the path to the server location where 
the export file(s) are to be stored. (Please note that involved software modules need access 
rights to this catalog.) Please note that you can create backups with unique names, 
including a date-time stamp: yyyy-mm-dd; hh:mm. This you do in the Scheduled jobs dialog, 
Path to Export File field. The strings to be inserted are e.g. %yyyy% for the current year etc., 
similar to http://docs.oracle.com/javase/7/docs/api/java/text/SimpleDateFormat.html. As an example, 
entering the compound string mybackups/Full_backup_%yyyy%-%MM%-%dd%.xls would 
give an export file Full_backup_2014-08-20.xls if the current date is 20 August, 2014. 
Similarly, the string mybackups/Full_backup_%yyyy%-%MM%-%dd% %kk%.%mm%.xls 
would give the export file Full_backup_2014-08-20 14.12.xls if the current date and time is 
20 August, 2014, 12 minutes past 2 in the afternoon. Please note that the exported files in 
the example are stored in the mybackups subdirectory of the base directory on the file 
system specified at installation time. Details can be found by clicking [more][more][more][more] in the Job 
result log. Please also note that e.g. colons and semicolons cannot be used due to file 
system requirements. 

3. Also, enter the interval in the ScheduleScheduleScheduleSchedule section. 
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4. If you want to keep all runs in the job result log, enter 0 in the Runs to keepRuns to keepRuns to keepRuns to keep field. 
5. If desired, enter the email address where export notifications are to be sent, and the sender 

email and name to be displayed in the notification email. 
6. Click ActiveActiveActiveActive to activate the job immediately. 
7. Click Create jobCreate jobCreate jobCreate job. 
 
For an existing job, click the job name and, in a similar way as described above, you can 
deactivate or activate the job, change parameters and then click Update JobUpdate JobUpdate JobUpdate Job to save your 
changes. 
 

 
 

Show expression (cron expressions)Show expression (cron expressions)Show expression (cron expressions)Show expression (cron expressions)    

If you want to fine-tune the schedule parameters you can use the "cron expression". Then Click 
Show expressionShow expressionShow expressionShow expression. 
A UNIX crontab-like pattern is a string split in five space-separated parts. Each part is intended 
as:  

1. Minutes subMinutes subMinutes subMinutes sub----patternpatternpatternpattern. During which minutes of the hour should the task been launched? 
The values range is from 0 to 59.  

2. Hours subHours subHours subHours sub----patternpatternpatternpattern. During which hours of the day should the task been launched? The 
values range is from 0 to 23. 

3. Days of month subDays of month subDays of month subDays of month sub----patternpatternpatternpattern. During which days of the month should the task been 
launched? The values range is from 0 to 31. 

4. Months subMonths subMonths subMonths sub----patternpatternpatternpattern. During which months of the year should the task been launched? 
The values range is from 1 (January) to 12 (December), otherwise this sub-pattern allows 
the aliases "jan", "feb", "mar", "apr", "may", "jun", "jul", "aug", "sep", "oct", "nov" and 
"dec". 
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5. Days of week subDays of week subDays of week subDays of week sub----patternpatternpatternpattern. During which days of the week should the task been 
launched? The values range is from 0 (Sunday) to 6 (Saturday), otherwise this sub-
pattern allows the aliases "sun", "mon", "tue", "wed", "thu", "fri" and "sat". 

The asterisk wildcard character is also admitted, indicating "every minute of the hour", "every 
hour of the day", "every day of the month", "every month of the year" and "every day of the 
week", according to the sub-pattern in which it is used.  

Once the scheduler is started, a task will be launched when the five parts in its scheduling 
pattern will be true at the same time.  
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Some examples:  

5 * * * *5 * * * *5 * * * *5 * * * * 
This pattern causes a task to be launched once every hour, at the begin of the fifth minute 
(00:05, 01:05, 02:05 etc.).  

* * * * ** * * * ** * * * ** * * * * 
This pattern causes a task to be launched every minute.  

* 12 * * Mon* 12 * * Mon* 12 * * Mon* 12 * * Mon 
This pattern causes a task to be launched every minute during the 12th hour of Monday.  

* 12 16 * Mon* 12 16 * Mon* 12 16 * Mon* 12 16 * Mon 
This pattern causes a task to be launched every minute during the 12th hour of Monday, 16th, 
but only if the day is the 16th of the month.  

Every sub-pattern can contain two or more comma separated values.  

59 11 * * 1,2,3,4,559 11 * * 1,2,3,4,559 11 * * 1,2,3,4,559 11 * * 1,2,3,4,5 
This pattern causes a task to be launched at 11:59AM on Monday, Tuesday, Wednesday, 
Thursday and Friday.  

Values intervals are admitted and defined using the minus character.  

59 11 * * 159 11 * * 159 11 * * 159 11 * * 1----5555 
This pattern is equivalent to the previous one.  

The slash character can be used to identify periodic values, in the form a/b. A sub-pattern with 
the slash character is satisfied when the value on the left divided by the one on the right gives 
an integer result (a % b == 0).  

*/15 9*/15 9*/15 9*/15 9----17 * * *17 * * *17 * * *17 * * * 
This pattern causes a task to be launched every 15 minutes between the 9th and 17th hour of 
the day (9:00, 9:15, 9:30, 9:45 and so on... note that the last execution will be at 17:45).  

All the fresh described syntax rules can be used together.  

* 12 10* 12 10* 12 10* 12 10----16/2 * *16/2 * *16/2 * *16/2 * * 
This pattern causes a task to be launched every minute during the 12th hour of the day, but 
only if the day is the 10th, the 12th, the 14th or the 16th of the month.  

* 12 1* 12 1* 12 1* 12 1----15,17,2015,17,2015,17,2015,17,20----25 * *25 * *25 * *25 * * 
This pattern causes a task to be launched every minute during the 12th hour of the day, but the 
day of the month must be between the 1st and the 15th, the 20th and the 25, or at least it 
must be the 17th.  

Finally cron4j lets you combine more scheduling patterns into one, with the pipe character:  

0 5 * * *|8 10 * * *|22 17 * * *0 5 * * *|8 10 * * *|22 17 * * *0 5 * * *|8 10 * * *|22 17 * * *0 5 * * *|8 10 * * *|22 17 * * * 
This pattern causes a task to be launched every day at 05:00, 10:08 and 17:22.  
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Workflows Workflows Workflows Workflows     

Workflows Workflows Workflows Workflows iiiintroductionntroductionntroductionntroduction    

With the workflow functionality in TermWeb you can define and automate tasks, control access 
permissions on the field level, and add styling to your term data, e.g. depending on term type or 
acceptability. 

A workflow is connected to a task in TermWeb, e.g. creating a concept or deleting a term. When 
the task is performed, the associated workflows are executed. For a full list of available tasks, 
see Workflow tasks. 

In a workflow you can define conditions, functions and validations to control what should 
happen when and where. 

ConditionsConditionsConditionsConditions    

Conditions provides more detailed control over when the workflow should be executed. You can 
add conditions for field values in a concept or term, and also check user group membership for 
the user performing the task that triggered the workflow. For instance, you can define a 
workflow only to be executed when the concept has status "Pending" and user is a member of 
the group "Translators". 

For more information about defining conditions, see Editing Workflows. 

FunctionsFunctionsFunctionsFunctions    

A workflow function defines some action that should be performed when the workflow is 
executed. For instance, you can set field values in the concept or term, hide fields or make them 
read-only when editing, or change the field style (color, font style etc). 

You can define the functions to be executed before or after the workflow's task. The functions 
to be executed before the task are defined as prefunctions in the workflow. The functions that 
should be executed when the task finishes are defined as postfunctions. For details about when 
pre- and postfunctions are executed for each task, see Workflow tasks. 

ValidationsValidationsValidationsValidations    

By adding validations to a workflow, you can define that some fields in the concept or term are 
required to have a value before saving, besides the fields already defined to be required in the 
dictionary definition. Using validations you can, for instance, require Definition to have a value 
if Status is set to Approved. 

Validations are only performed when saving after an editing task. For more information about 
validations see Validations under Editing Workflow Details below. 

Create a workflowCreate a workflowCreate a workflowCreate a workflow    

To create a new workflow you must be logged in as an administrator in TermWeb. Go to the 
Admin view and click on the WorkflowsWorkflowsWorkflowsWorkflows icon. 



 
94 (123) 

© 2018 Interverbum Technology AB Admin_and_User_Manual_TWPro_V3.18_R1B_EN.rtf 2018-02-23 

 
 

This opens the View WorkflowsView WorkflowsView WorkflowsView Workflows screen. Here you see all defined workflows in the system. To 
create a new workflow, click Add WorkflowAdd WorkflowAdd WorkflowAdd Workflow. 

This opens the Add New WorkflowAdd New WorkflowAdd New WorkflowAdd New Workflow screen. 

 

Here you enter a name for the workflow, set the order of execution for this workflow within the 
possible set of workflows for the dictionary, type an optional description, select the task (or 
tasks) that is to initiate the workflow (see Tasks for more information), and select the dictionary 
to which the workflow is connected. You can also set whether you want the workflow to be 
active or not. 
Note: Note: Note: Note: If you want either of two tasks to initiate the workflow, e.g. if both Create Term and 
Update Term is to initiate the workflow, Ctrl-click these tasks in the Task(s)Task(s)Task(s)Task(s) list. 

Workflow tasksWorkflow tasksWorkflow tasksWorkflow tasks    

The following table lists the available workflow tasks and when pre- and postfunctions are 
executed 

TaskTaskTaskTask    Prefunctions run whenPrefunctions run whenPrefunctions run whenPrefunctions run when    Postfunctions run whenPostfunctions run whenPostfunctions run whenPostfunctions run when    

Create Concept 
User is opening the Edit screen for a 
new concept entry 

The concept is saved 

Edit Concept 

User is opening a concept entry for 
editing 
or 

The concept entry is added to the 
Grid View  

The concept is saved 

Delete Concept 
User is selecting a concept entry for 
deletion 

After the concept is deleted from the 
database 
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Add Term 

User clicks "Add term" when editing a 
concept entry 
orororor 
User clicks "Edit term" on a term 
entry that not has been saved to 
database 
orororor    
User selects "Add term" from context 
menu in the Grid View  

User clicks "Save" in the term entry 
fields panel 
or 

Directly after prefunctions if editing 
in the Grid View  

Create Term 

A new concept entry is saved (for 
each term entry) 
orororor    
A concept entry is saved after editing 
(for each new term entry) 

Directly after prefunctions 

Edit Term 

User clicks "Edit term" on a term 
entry already stored in database 
when editing a concept entry 

User clicks "Save" in the term entry 
fields panel 

Never called when editing in the Grid ViewNever called when editing in the Grid ViewNever called when editing in the Grid ViewNever called when editing in the Grid View    

Update Term 
A concept entry is saved after editing 
(for each modified term entry) 

Directly after prefunctions 

Delete Term 

A concept entry is saved after editing 
(for each deleted term entry) 
orororor 
A concept entry is deleted (for each 
term entry) 

Directly after prefunctions 

View Term in List A term is displayed in the term list Directly after prefunctions 

View Concept 
A concept entry is displayed in the 
result window 

Directly after prefunctions 

View Term 
A term entry is displayed (collapsed 
or expanded) in the result window 

Directly after prefunctions 

Select Term when 
Editing 

A term entry is selected in the Edit 
concept window 

Directly after prefunctions 

NeveNeveNeveNever called when editing in the Grid Viewr called when editing in the Grid Viewr called when editing in the Grid Viewr called when editing in the Grid View 

Import Term Data An import is started 
When the imported is completed, but 
not if the import is cancelled by the 
user 

Editing Editing Editing Editing wwwworkflow orkflow orkflow orkflow ddddetailsetailsetailsetails    

To specify what actions should be performed by a workflow you click "Edit Details" in the 
workflow list page. The "Edit Workflow Details" view opens. 
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ConditionsConditionsConditionsConditions    

The conditions in a workflow determine when the workflow is executed. You can define a logical 
statement based on values in fields or the user's group. Click on "Edit Conditions" to open the 
conditions editor. 

Only picklist fields can normally be used in workflow conditions.  
From version 3.12, also "Created by" and "Changed by" fields can be used in conditions, as well 
as values in normal text fields. For "Created by" and "Changed by", EQUALS and NOT EQUALS 
can be used, and login names should be used. For values in normal text fields, the EQUALS, NOT 
EQUALS, CONTAINS, AND NOT CONTAINS operators can be used. The selected field values should 
match the values in the entry being displayed or edited for the workflow to run. 
However, if one of the Edit Concept and Update Term tasks is selected (alone), a change of the 
contents of any field can be set to trigger a workflow email. For this to happen, select the Field 
changed condition. 

If the workflow task affects a concept, e.g. Edit Concept or View Concept, and you have defined 
term level fields in the workflow conditions, all terms in the concept must fulfill the term level 
conditions. If the task affects a term, e.g. Edit Term or View Term in List, only the selected term 
and its concept must fulfill the conditions. 

FunctionsFunctionsFunctionsFunctions    

Workflow functions are actions that the workflow performs when executed. They are divided 
into Prefunctions and Postfunctions, where the prefunctions are executed at the beginning of 
the workflow's task, and the postfunctions are executed at the end. See Workflow tasksWorkflow tasksWorkflow tasksWorkflow tasks above 
for a full description. 

Function typesFunction typesFunction typesFunction types    

The following workflow function types are available: 

• Set Field Value 
Sets the value for a field in the current entry. 

• Render Field 
Changes how a field in the current entry is rendered, e.g. hidden or read-only. 

• Style Field 
Changes the appearance of a field in the current entry, e.g. color or size. 

• Send Email 
Sends a customizable email to a single user or one or more groups of users. Emails can 
be sent directly or collected in a digest sent on a regular interval or when the initiating 
task has been performed a certain number of times. 

• Send Reminder Email 
Sends a customizable email to a single user or group of users with delay. Delay value 
may use hours or days as time units. See details in the Procedural tips section. 

• Set Permission Scheme 
Temporarily changes the permission scheme for the user for the duration of the task. 
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• Sort Terms 
Sorts the terms in a concept when displayed in the result window, based on a specific 
field value in the term. 

Not all functions are applicable for all tasks, or as pre- or postfunctions. Only applicable 
functions are listed in the Add Function screen. 

 

ValidationsValidationsValidationsValidations    

Validations allow you to specify fields that should be required during an editing operation, 
besides the fields already defined as required in the dictionary definition. The workflow 
validations are checked when the entry is saved, and if a required value is missing the user will 
be informed and not able to save until a value is entered in the required field. 
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Sorting workflows in execution order in workflow listSorting workflows in execution order in workflow listSorting workflows in execution order in workflow listSorting workflows in execution order in workflow list    

To specify in which order the workflows of a certain dictionary are executed, proceed as follows: 
This means that the workflow with the highest number will be executed last, that is; take 
priority over the workflows with lower numbers if in conflict. 

 

1. Click AdminAdminAdminAdmin (Admin view) > WorkflowsWorkflowsWorkflowsWorkflows.  
2. Select the desired dictionary in the DictionaryDictionaryDictionaryDictionary dropdown. 
3. The execution order is shown in the Order column. To decrease the order number for a 

certain workflow, click the arrow above the number. To increase the number, click the 
arrow below the number. 

Usage examples of TermWeb woUsage examples of TermWeb woUsage examples of TermWeb woUsage examples of TermWeb workflow functionsrkflow functionsrkflow functionsrkflow functions    

A) Force term creators to fill in another field if a certain value is chosen for a certain fieldA) Force term creators to fill in another field if a certain value is chosen for a certain fieldA) Force term creators to fill in another field if a certain value is chosen for a certain fieldA) Force term creators to fill in another field if a certain value is chosen for a certain field    

In this example, to check that the definition is filled in when the concept status is changed to 
Approved. 

4. Click AdminAdminAdminAdmin (Admin view) > WorkflowWorkflowWorkflowWorkflowssss.  
5. Click Add WorkflowAdd WorkflowAdd WorkflowAdd Workflow. 
6. Name the workflow function, add a description, select "Edit concept" in the TaskTaskTaskTask(s)(s)(s)(s) list 

and specify for which dictionary the workflow function should apply. Then click SaveSaveSaveSave. 
7. Click Edit DetailsEdit DetailsEdit DetailsEdit Details for the workflow function. 
8. To the right of Defined conditionsDefined conditionsDefined conditionsDefined conditions, click Edit Conditions Edit Conditions Edit Conditions Edit Conditions and specify under what 

condition the workflow function should be activated ("Status is Approved" in the 
example). 

9. To the right of Defined validationsDefined validationsDefined validationsDefined validations, click Edit ValidationsEdit ValidationsEdit ValidationsEdit Validations, and, on the DefinitionDefinitionDefinitionDefinition field 
line, click the Not required Not required Not required Not required value to toggle it to Required Required Required Required and click SaveSaveSaveSave. 

10. Click SaveSaveSaveSave again. 
11. Activate the workflow function by clicking the text Inactive Inactive Inactive Inactive to toggle it to Active.Active.Active.Active. 

Now, when the status of a concept is changed to Approved, the user will get a signal that the 
definition is missing when trying to save the concept:  
"Field required by workflow. Please enter Definition." 
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B) Mark unapproved terms in term list with another color (red)B) Mark unapproved terms in term list with another color (red)B) Mark unapproved terms in term list with another color (red)B) Mark unapproved terms in term list with another color (red)    

1. Click AdminAdminAdminAdmin (Admin view) > WorkflowsWorkflowsWorkflowsWorkflows.  
2. Click Add WorkflowAdd WorkflowAdd WorkflowAdd Workflow. 
3. Name the workflow function, add a description, select "View term in list" in the TaskTaskTaskTask(s)(s)(s)(s) 

list and specify for which dictionary the workflow function should apply. Then click SaveSaveSaveSave. 
4. Click Edit DetailsEdit DetailsEdit DetailsEdit Details for the workflow function. 
5. To the right of Defined conditionsDefined conditionsDefined conditionsDefined conditions, click Edit Conditions Edit Conditions Edit Conditions Edit Conditions and specify under what 

condition the workflow function should be activated and click SaveSaveSaveSave. 
6. To the right of Defined postfunctionsDefined postfunctionsDefined postfunctionsDefined postfunctions, click Add FunctionAdd FunctionAdd FunctionAdd Function, select Style FieldStyle FieldStyle FieldStyle Field and click 

AddAddAddAdd. 
7. Select TermTermTermTerm in the FieldFieldFieldField dropdown, red color in the CoCoCoColorlorlorlor field and font size, style and 

decoration as desired. 
8. Click Save.Save.Save.Save.    

 
9. Click Save.Save.Save.Save. 
10. Activate the workflow function by clicking the text Inactive Inactive Inactive Inactive to toggle it to Active.Active.Active.Active. 

    
Note!Note!Note!Note! 
If you also want the occurrence of a deprecated term to be signaled in red in the result window, 
add the task "View term" to the workflow. If you want to signal deprecated terms in a different 
way in the result window, create a separate workflow for the task "View term"! 
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C) Signal the addition of a term (or terms) by email from the C) Signal the addition of a term (or terms) by email from the C) Signal the addition of a term (or terms) by email from the C) Signal the addition of a term (or terms) by email from the systemsystemsystemsystem 

1. Click AdminAdminAdminAdmin (Admin view) > WorkflowsWorkflowsWorkflowsWorkflows. 
2. Click Add WorkflowAdd WorkflowAdd WorkflowAdd Workflow. 
3. Name the workflow function, optionally add a description, select "Create term" in the 

TaskTaskTaskTask list and specify for which dictionary the workflow function should apply. Then click 
SaveSaveSaveSave. 

4. Click EdiEdiEdiEdit Detailst Detailst Detailst Details for the workflow function. 
5. To the right of Defined conditionsDefined conditionsDefined conditionsDefined conditions, click Edit Conditions Edit Conditions Edit Conditions Edit Conditions and specify under what 

condition the workflow function should be activated ("Sections is Suggestions" in the 
example) and click SaveSaveSaveSave. 

6. To the right of Defined posDefined posDefined posDefined postfunctionstfunctionstfunctionstfunctions, click Add FunctionAdd FunctionAdd FunctionAdd Function, select Send EmailSend EmailSend EmailSend Email, and click 
AddAddAddAdd. 

7. Enter info as desired (send notification to group or to one user), if to send a TTTText ext ext ext onlyonlyonlyonly 
email or include an HTMLHTMLHTMLHTML    reportreportreportreport of affected <s in the email, and whether to collect info 
about more than one event in an email, e.g. daily (Send emails as digestsSend emails as digestsSend emails as digestsSend emails as digests). 
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8. If you select an HTML report, click Select ColumnsSelect ColumnsSelect ColumnsSelect Columns and decide which columns to include: 

 
 

9. Click SaveSaveSaveSave to save the report column settings. 
10. Click SaveSaveSaveSave. 

 
11. Click SaveSaveSaveSave again. 
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12. Activate the workflow function by clicking the text Inactive Inactive Inactive Inactive to toggle it to Active.Active.Active.Active. 
    
As an example, here a terminologist could get a list of term suggestions entered by other people 
in the organization on a regular basis. In that case, a condition that the term suggestion is 
entered in an "open" suggestion section should be added to the workflow. This way, the addition 
of new terms by terminologists in other, published, sections will not be signaled to the selected 
user or user group: 
 
Resulting HTML report email when terms created in Suggestions section: 

 
If the report has line breaks within words, a tip is, for Outlook 2007 and later, to open the mail, 
and then choose “View in browser”. 
 
DDDD))))    Automatically set concept status to Approved if all terms have Process status FinAutomatically set concept status to Approved if all terms have Process status FinAutomatically set concept status to Approved if all terms have Process status FinAutomatically set concept status to Approved if all terms have Process status Finalizedalizedalizedalized    
Simply create a workflow like this: 

1. Click AdminAdminAdminAdmin (Admin view) > WorkflowsWorkflowsWorkflowsWorkflows. 
2. Click Add WorkflowAdd WorkflowAdd WorkflowAdd Workflow. 
3. Name the workflow function, add a description, select "Edit concept" in the TaskTaskTaskTask list and 

specify for which dictionary the workflow function should apply. Then click SaveSaveSaveSave. 
4. Click Edit DetailsEdit DetailsEdit DetailsEdit Details for the workflow function. 
5. To the right of Defined conditionsDefined conditionsDefined conditionsDefined conditions, click Edit Conditions Edit Conditions Edit Conditions Edit Conditions and specify under what 

condition the workflow function should be activated. 

 
6. Click SaveSaveSaveSave. 
7. To the right of Defined postfunctionsDefined postfunctionsDefined postfunctionsDefined postfunctions, click Add FunctionAdd FunctionAdd FunctionAdd Function, select Set Field Value Set Field Value Set Field Value Set Field Value and click 

AddAddAddAdd. 
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8. Select StatusStatusStatusStatus in the FieldFieldFieldField dropdown, and "Approved" in the Set value to Set value to Set value to Set value to field and click 
SaveSaveSaveSave. 

 
9. Click SaveSaveSaveSave again. 
10. Activate the workflow function by clicking the text Inactive Inactive Inactive Inactive (in the Status column) to 

toggle it to Active.Active.Active.Active. 
E)E)E)E)    Changing the sort order of terms in the result windowChanging the sort order of terms in the result windowChanging the sort order of terms in the result windowChanging the sort order of terms in the result window    
Normally, terms in the result window are displayed with the selected (source language) term 
first, followed by the possible source language synonym(s), then the terms in the other 
languages, in the language order of the current dictionary, grouped by language.  
If you, as an example, want to sort the terms within the concept with all full-form terms first, 
followed by all short-form terms or acronyms, do as follows:  

1. Create a workflow for the View Concept task and click SaveSaveSaveSave: 
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2. Click Edit Details on the line of the workflow, and the following dialog will appear: 

 
3. By Defined postfunctionsDefined postfunctionsDefined postfunctionsDefined postfunctions, click Add functionAdd functionAdd functionAdd function, and the following dialog will appear: 

 
4. Select Sort TermsSort TermsSort TermsSort Terms and click AddAddAddAdd. 

 
5. Select the term field, for which the value will decide the sorting (Term type in the 

example), and e.g. IncreasingIncreasingIncreasingIncreasing and Sort within conceptSort within conceptSort within conceptSort within concept and click SaveSaveSaveSave twice. 
The terms within the concept will now be sorted first by Term type and then by language 
in the result window. 
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F) Make a change of any field on concept or term level trigger a workflow emailF) Make a change of any field on concept or term level trigger a workflow emailF) Make a change of any field on concept or term level trigger a workflow emailF) Make a change of any field on concept or term level trigger a workflow email    

If you want any change of the contents of a certain field (also of a text field) trigger a 
workflow, proceed as follows: 

1. Create a new workflow: Click AdminAdminAdminAdmin (Admin view) > WorkflowsWorkflowsWorkflowsWorkflows and then    Add workflowAdd workflowAdd workflowAdd workflow. 
Give the workflow a name and description, select the Edit Concept task and the desired 
dictionary and then click SaveSaveSaveSave. Then click Edit detailsEdit detailsEdit detailsEdit details for the workflow. 

2. Click Edit ConditionsEdit ConditionsEdit ConditionsEdit Conditions and select the Field changedField changedField changedField changed condition: 

 
3. Select the field that is to trigger the workflow after isisisis and click Save:Save:Save:Save: 

 
4. Create a Send email postfunction: 

 
5. Click SaveSaveSaveSave to save the Send email function. 

 
6. Click SaveSaveSaveSave again to save the workflow.  
7. Activate the workflow, if not already done in step 1 above. 
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Projects Projects Projects Projects     

Introduction to the Projects toolIntroduction to the Projects toolIntroduction to the Projects toolIntroduction to the Projects tool    

With the Projects function in TermWeb you can define and automate certain project-related 
tasks.  
A project may as an example be a batch of new term records to be worked on. You should 
define the project by a filter, e.g. a "batch number" field value, define a workflow for certain 
tasks, that can send a customizable email to a User or a User group, when the workflow 
conditions have been met and the task has been performed. The email can be sent at regular 
intervals, once the task has been performed or when the task has been performed a selected 
number of times, in the same way as for workflow emails initiated from Admin > Workflows. 

Note: During the work (after clicking Save if you want to save your work), you can always revert 
to the Administration icons screen by clicking « « « « Back to AdministrationBack to AdministrationBack to AdministrationBack to Administration. 

Creating a new projectCreating a new projectCreating a new projectCreating a new project    

1. Click Add Add Add Add project. 
2. Select the dictionary for which the project is to apply and click Add ProjectAdd ProjectAdd ProjectAdd Project. 
3. Fill in the desired data on the tabs displayed: 

A) The GeneralGeneralGeneralGeneral tab: 

An example:  
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Define any variables you might need for emails.  
Click AddAddAddAdd and enter (short variable) name and (long) value. 

Click AddAddAddAdd again to save the variable and then click SaveSaveSaveSave. 
 
B) The FilterFilterFilterFilter tab: 
Click Edit FiltEdit FiltEdit FiltEdit Filterererer and create a filter for the term records to be included in the project.  
An example: 

 
 
After defining the filter, click SaveSaveSaveSave. 
Please note: Filters defined in the Project module will be selectable from the end of the 
dropdown in search view, preceded by [Project]: 

 
However, these filters are only editable in the Project module. 
C: The WorkflowWorkflowWorkflowWorkflow tab: 
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Fill in the desired name of the workflow, select the task (out of the available tasks) to 
initiate the workflow and the condition(s) under which the workflow is to be initiated. 
An example: 

 
An example where all concepts of the project (batch) are completed, i.e. have terms in 
all, or at least a few, of the available languages: 
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Click Add FunctionAdd FunctionAdd FunctionAdd Function. 
Fill in the email or reminder recipients and other conditions (see example below). 
Please note: The For All Concepts workflow can only use the Send email and Send 
reminder functions. 
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Here, you can insert field names etc.  
If you want to make use of an earlier defined variable in the email text, right-click to 
insert the desired variable: 

 
4. Click SaveSaveSaveSave to save the function. You may then add another function, e.g. a reminder 

email. 
Click SaveSaveSaveSave to save the workflow. 

5. Click SaveSaveSaveSave to save the project. 
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Editing a projectEditing a projectEditing a projectEditing a project    

Click the name of the desired project in the list of defined projects and edit as desired (see 
details above). 

 
Here, you can also activate or deactivate a project (click InactiveInactiveInactiveInactive or ActiveActiveActiveActive respectively in the 
Status column) or delete an obsolete project by clicking DeleteDeleteDeleteDelete on the line of the desired project. 

 

Change Password: Change your passwordChange Password: Change your passwordChange Password: Change your passwordChange Password: Change your password    
Change your password. If you, as an administrator, want to change passwords for other users, 
click Admin viewAdmin viewAdmin viewAdmin view and choose UsersUsersUsersUsers. Please note that a password change may be required at 
certain intervals, this defined for your group by the administrator. 

1. Click Change PasswordChange PasswordChange PasswordChange Password. 
2. Enter the old password once and the new password twice. 
3. Click SaveSaveSaveSave. 
4. Click Search ViewSearch ViewSearch ViewSearch View if you want to return to searching for terms (or Log outLog outLog outLog out). 

Administrator Tools: Reindex a dictionaryAdministrator Tools: Reindex a dictionaryAdministrator Tools: Reindex a dictionaryAdministrator Tools: Reindex a dictionary    

 
Sometimes it can be helpful to reindex a dictionary in order to increase the speed of a search. To 
reindex: 

1. Click Administrator ToolsAdministrator ToolsAdministrator ToolsAdministrator Tools. 
2. Select the dictionary you wish to reindex from the DictionaryDictionaryDictionaryDictionary field. 
3. Click Start ReindexingStart ReindexingStart ReindexingStart Reindexing. 
4. Click OKOKOKOK when a message that the reindexing has been completed appears in the 

window. 

Administrator Tools: Convert static crossAdministrator Tools: Convert static crossAdministrator Tools: Convert static crossAdministrator Tools: Convert static cross----references to dynamic onesreferences to dynamic onesreferences to dynamic onesreferences to dynamic ones    

 
If you want any links referring to existing terms to change if the referred-to term name is 
changed, proceed as follows: 

1. Click AdminisAdminisAdminisAdministrator Toolstrator Toolstrator Toolstrator Tools. 
2. Select the dictionary you wish to reindex from the DictionaryDictionaryDictionaryDictionary field. 
3. Click Make term links dynamicMake term links dynamicMake term links dynamicMake term links dynamic. 
4. Click OKOKOKOK when a message appears that the conversion is ready. 
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Administrator Tools: Message for error pageAdministrator Tools: Message for error pageAdministrator Tools: Message for error pageAdministrator Tools: Message for error page    
1. Click Administrator ToolsAdministrator ToolsAdministrator ToolsAdministrator Tools. 
2. Enter the desired message in the message field. 
3. If desired, test how the message would look clicking PreviewPreviewPreviewPreview. 

If you want to reset the message to the standard (English) text, please click Reset to Reset to Reset to Reset to 
default text default text default text default text at any time. 

4. Click SaveSaveSaveSave when ready. 
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Administrator TAdministrator TAdministrator TAdministrator Tools: Password strengthools: Password strengthools: Password strengthools: Password strength    
1. Click Administrator ToolsAdministrator ToolsAdministrator ToolsAdministrator Tools. 
2. Select the desired password requirements in the Predefined patternsPredefined patternsPredefined patternsPredefined patterns dropdown, or enter 

a custom-made regular expression. 
3. In the Validation messageValidation messageValidation messageValidation message field, enter a suitable error message to be displayed when a 

password not fulfilling the requirements is later entered. 
4. If desired, test if a certain password fulfills the newly defined criteria by entering it in 

the Test stTest stTest stTest strrrringinginging field and clicking TestTestTestTest. 
5. When ready, click Save password patternSave password patternSave password patternSave password pattern. 

 

Usage StatisticsUsage StatisticsUsage StatisticsUsage Statistics    
To display usage statistics over user visits, time spent, and user origin per day, month or year for 
your TermWeb installation, proceed as follows:  

1. Click StatisticsStatisticsStatisticsStatistics. 
2. For usage details regarding a certain day, click Details Details Details Details on the corresponding line. 

 
To show statistics for another month, click the name of month previous to or following the 
currently displayed month. 

Entering License information Entering License information Entering License information Entering License information     
When you install TermWeb at your own server, you will have got a license key together with the 
installation package. After installation, open TermWeb, go to AdminAdminAdminAdmin > LicenseLicenseLicenseLicense, paste the license 
key into the Enter new lEnter new lEnter new lEnter new licenseicenseicenseicense area and click Apply. Apply. Apply. Apply. Thereafter, you will be able to use the 
purchased number of user licenses for the specified period. 
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Using language groupUsing language groupUsing language groupUsing language groupssss    
If you want to automatically give similar access rights to terminologists/editors for different 
languages, but only to terms in their respective language, you can use the language group 
function. 
 
Proceed as follows: 
1. Go to AdminAdminAdminAdmin > DictionariesDictionariesDictionariesDictionaries and click the desired (or any) dictionary. Then either  

a) click AddAddAddAdd (by the Languages list) to add the language (if not already in the dictionary) 
or  
b) select the language and click EditEditEditEdit.  
Then select the Create Language GroupCreate Language GroupCreate Language GroupCreate Language Group checkbox: 

 
2. Click Save Save Save Save and Save ChanSave ChanSave ChanSave Changesgesgesges. 
3. Then, using the AdminAdminAdminAdmin > Group MembersGroup MembersGroup MembersGroup Members function, place the users in the correct language 

groups. 
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4. The group and all its users will now automatically, as default, be given the right to edit just 
the language in question for all dictionaries (all other languages being locked): 

 
Please notePlease notePlease notePlease note: If new languages are later added to the dictionary, the Lock Languages settings will 
have to be adapted accordingly. 
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Please note that the language groups can be the target of workflow-originated emails: 

Using languagUsing languagUsing languagUsing language groups for emailse groups for emailse groups for emailse groups for emails    
If you wish to use Language group as recipient, the workflow must be triggered by a term-level 
event (the supported tasks are Create Term, Update Term and Delete Term). Then, if a term in a 
specific language is created, updated or deleted, an email will be sent to the members of the 
corresponding language group. 
So, create a term-related workflow and select the Language group radio button as shown 
below:  
Please note that you only have to select the Language group radio button, no language groups 
will in this case have to be selected with the Add Group link. 

 
Save the postfunction, and the Edit Workflow Details Screen will display the postfunction as 
follows: 

 
Then save the workflow.
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If you want an HTML concept summary report to be sent in the email, select the HTML reportHTML reportHTML reportHTML report 
radio button, click Select ColumnsSelect ColumnsSelect ColumnsSelect Columns and select the languages, concept-level-fields and term-level 
fields to be included in the report. 

 
When you are ready, click SaveSaveSaveSave, Then again SaveSaveSaveSave (for the Send email function) and then SaveSaveSaveSave 
again for the workflow. 
 
When the workflow criteria are met, a report similar to the one below will be sent in an email to 
the relevant user(s): 
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Terms used in this documentTerms used in this documentTerms used in this documentTerms used in this document    
Term recordTerm recordTerm recordTerm record: A term record is the part of a structured terminological data omnibus that is 
applicable to a specific concept. (This concept is expressed normally by different term 
equivalents in various languages.)    
Term equivalentTerm equivalentTerm equivalentTerm equivalent: Term equivalent is used to refer to words or expressions that represent the 
same or a similar concept in different languages.  

Procedural Procedural Procedural Procedural ttttipsipsipsips    

Create a copy of an existing dictionaryCreate a copy of an existing dictionaryCreate a copy of an existing dictionaryCreate a copy of an existing dictionary    

If you want to create an identical copy of a dictionary within the same TermWeb client, proceed 
as follows. (In this case, there will be no exported dictionary definition file to save):    

1. Click AdminAdminAdminAdmin >    DictionariesDictionariesDictionariesDictionaries and click CopyCopyCopyCopy on the line of the dictionary you want to copy. 
2. Then choose if you want to create an empty identical dictionary (Structure Only) or 

create a full copy of the dictionary (Structure and Data). Then click Copy DictionaryCopy DictionaryCopy DictionaryCopy Dictionary. 

  

Alternative stepAlternative stepAlternative stepAlternative step----bybybyby----step instruction for copying step instruction for copying step instruction for copying step instruction for copying a dictionary a dictionary a dictionary a dictionary between TermWeb clients:between TermWeb clients:between TermWeb clients:between TermWeb clients:    
Note: You export and import the dictionary STRUCTURE from the Admin > Dictionaries 
dialog, whereas you export and import the dictionary CONTENTS from the Admin > Export 
and Admin > Import dialogs respectively. 
1. Click AdminAdminAdminAdmin    > Dictionaries> Dictionaries> Dictionaries> Dictionaries    in client 1. 
2. Click the ExportExportExportExport link on the line of the desired dictionary (optionally including filter 

definitions and custom layout) and save the resulting dictionary definition file. 
3. If you also want to fill the new dictionary with all or parts of the contents of the first 

dictionary: Still in client 1, click Admin > ExportAdmin > ExportAdmin > ExportAdmin > Export, create and/or just select an export 
settings file for the first dictionary, if desired with a filter, click ExportExportExportExport and save the term 
data file at a convenient location. 

4. In client 2, click Import DictionaryImport DictionaryImport DictionaryImport Dictionary, browse for the dictionary definition file exported in 
step 2, click OpenOpenOpenOpen and then Import DictionaryImport DictionaryImport DictionaryImport Dictionary. Then an empty "clone" of the first 
dictionary will be created (with the same sections, languages, and fields), that you can 
rename etc. 

5. Still in client 2, click Admin > ImportAdmin > ImportAdmin > ImportAdmin > Import, create an import settings file for the new 
dictionary, select this settings file and click ImportImportImportImport. Browse for and select the term data 
file exported in step 3 and then click NextNextNextNext etc. and the data will be imported into the 
new dictionary. Please note that the Concept IDs in the source and target dictionaries 
will normally differ. Note that the File repository can be copied (ZIP) in a similar way. 
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Create a filter for displaying only acceptable terms in the term listCreate a filter for displaying only acceptable terms in the term listCreate a filter for displaying only acceptable terms in the term listCreate a filter for displaying only acceptable terms in the term list    

Proceed as follows to make a filter that will only make terms with Usage status Preferred or 
Admitted display in the term list. This filter will thus exclude terms with Usage status Not 
recommended or Obsolete, as well as terms with no usage status marking, from the term list. 
First select Term in the Filtering outFiltering outFiltering outFiltering out dropdown box. 
Then specify the filter as follows: 

 

If applied, this filter makes only terms show up in the term list if they are neither classified as : 
1) Not recommended 
nor 
2) Obsolete 
nor are 
3) unclassified 
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An alternative giving the same results is of course to use a filter where terms with either of the 
two allowed status values are displayed: 

  
 

Running two TermWeb sessions simultaneously from a computerRunning two TermWeb sessions simultaneously from a computerRunning two TermWeb sessions simultaneously from a computerRunning two TermWeb sessions simultaneously from a computer    

You should never run two TermWeb sessions from the same brand of web browser in the same 
computer. This is because the common cache is used to speed up operation. 
It is however possible to use two different logins, e.g. admin and read-only user, from the same 
computer if different web browser brands are used for the two sessions. 

Using date fields in filtersUsing date fields in filtersUsing date fields in filtersUsing date fields in filters    

If you want to use the entered values in a filter, see the filter example below that will return all 
concepts with a value of the Batch date field being 1 January through 31 January 2014, 
inclusive: 
 

 

See also filter example 4 for use of relative dates in the Use filters to search and export section. 
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SSSSend Reminder Email workflow postfunctionend Reminder Email workflow postfunctionend Reminder Email workflow postfunctionend Reminder Email workflow postfunction    

To enable a reminder email to be sent to a user or group, do as follows: 
1. Go to Admin > Workflows Admin > Workflows Admin > Workflows Admin > Workflows and click Edit DetailsEdit DetailsEdit DetailsEdit Details on the line of the desired workflow. 
2. Click Add FunctionAdd FunctionAdd FunctionAdd Function in the Defined postfunctions section. 
3. Select the Send Reminder EmailSend Reminder EmailSend Reminder EmailSend Reminder Email radio button and click Add. 

 
4. Select email recipient(s). conditions and delay before the reminder is sent. Also, add a 

message to be included in the email: 

 
5. Click SaveSaveSaveSave twice to save the workflow and then make sure it is activated. 
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TermWeb glossaryTermWeb glossaryTermWeb glossaryTermWeb glossary    

client An entirely separate part of a TermWeb server installation with its own set 
of users, user groups, dictionaries etc. 

dictionary a term database with a certain structure, i.e. combination of languages as 
well as term-level and concept-level fields (including domain). A dictionary 
is thus a major part of the database with a given structure, e.g. a limited set 
of languages and fields.  

main and 
additional 
dictionaries 

The main dictionary is the user's first-choice dictionary. Additional 
dictionaries can be selected during term searches, and give more search hits 
as long as the additional dictionaries contain terms in the currently selected 
source language. 

section a physical part of a dictionary. Terminological entries in different sections 
of the same dictionary share the field, language and domain setup of the 
dictionary. Permissions to a section can be given per user group.  

domain subject area. A concept-level data category used for classification of full 
terminological entries. Domains and subdomains are organized in a multi-
level tree structure (defined per dictionary by the TermWeb administrator). 
A concept can belong to more than one domain. 

concept unit of knowledge created by a unique combination of characteristics.  
For TermWeb, often used as a synonym to a terminological entry, e.g. 
including a definition and at least one term in one language. 

concept-level 
fields 

fields containing information referring to the whole [terminological] entry. 
Examples are Definition, Source of definition, Image.  

term-level field a field applicable to a term, i.e. than can be given a value to further specify 
a term. Examples are Context, Part of speech, Gender, Usage status.  
Just as concept-level fields, term-level fields can be defined as required, 
picklist, multivalued, text, etc.  

user group a collection of one or more users having the same roles and thus 
permissions to the dictionaries and their sections  

user a person normally having a unique login name, used by one person (or 
external software via API) at a time. (The exception is the guest user, if 
activated, where more than one read-only user can be logged in at the 
same time.) The permissions of a user is defined by what group(s) the user 
belongs to.  

term list the list (to the left in the search view) of all or a subset of terms (fulfilling 
the search string criteria, plus possible filter criteria and selected domain(s) 
in the selected source language in the presently selected dictionary 
section(s) and any additional dictionary or dictionaries 

result window the lower right part of the TermWeb search view, presenting concept and 
term-level data for the selected (clicked) term in the term list 
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